
2 õ÷kMk-3 (rð»kÞðkh «§ku)

1. HTML yux÷u þwt ? Ãkku÷eMk fkuLMxuçk÷ / ÷kufhûkf, íkk. 06-01-2019

(A) High Text Mark Language

(B) High Text Machine Language

(C) Hyper Text Machine Language

(D) Hyper Text Markup Language

2. íkMkðehkuLku rzrsx÷ MðYÃk{kt YÃkktíkh fhðk {kxu fÞk MkkÄLkLkku
WÃkÞkuøk ÚkkÞ Au ?      õ÷kfo, íkk. 16-9-2018

(A) {kurLkxh (B) MfuLkh
(C) r«Lxh (D) nkzo rzMf

3. MS Excel VkR÷Lkwt yuõMkxuLþLk þwt nkuÞ Au ?
BÞwr™rMkÃk÷ MkurLkxhe RLMÃkuõxh, 18-02-2018

(A) .ods (B) .xls (C) .exc (D) .exl

4. Lke[uLkk{ktÚke fÞku rðfÕÃk Control Panel {kt òuðk {¤íkku LkÚke?
r‚r™Þh õ÷kfo …heûkk, 13-08-2017

(A) Sound (B) Mouse

(C) Display (D) My Account

5. yuf ðuçkÃkus ÃkhÚke çkeò ðuçkÃkus Ãkh sðkLke MkwrðÄk fkuý ykÃku Au?
r‚r™Þh õ÷kfo …heûkk, 13-08-2017

(A) nkRÃkh ®÷f (B) {kMxh ®÷f
(C) òuRLx ®÷f (D) fuMfu®zøk ®÷f

6. ykuÃkLk ykurVMk{kt ðzo yuÂÃ÷fuþLk suðwt fkÞo fhíke yuÂÃ÷fuþLk
fE Au ? r‚r™Þh õ÷kfo …heûkk, 13-08-2017

(A) IMPRESS

(B) WRITER

(C) CALC

(D) (A), (B), (C) ºký{ktÚke yufÃký Lknª

7. MS Power Point{kt M÷kRz þku þY fhðk {kxuLke VtfþLk fe fE Au?
nuz õ÷kfo / ‚{ks fÕÞký r™heûkf …heûkk, 30-04-2017

(A) F4 (B) F5 (C) F6 (D) F7

8. IP Lkwt Ãkqhwt Lkk{ þwt Au ?
nuz õ÷kfo / ‚{ks fÕÞký r™heûkf …heûkk, 30-04-2017

(A) Information	Protocol	 (B)	 Intranet	Protocol
(C) Internal Protocol (D) Internet Protocol

9. rçkLksYhe {uR÷Lku fÞk Lkk{u yku¤¾ðk{kt ykðu Au ?
nuz õ÷kfo / ‚{ks fÕÞký r™heûkf …heûkk, 30-04-2017

(A) Junk Mail (B) Temp Mail
(C) Extra Mail (D) Trash Mail

10. HTTP Lkwt Ãkqhwt Lkk{ þwt Au ?
nuz õ÷kfo / ‚{ks fÕÞký r™heûkf …heûkk, 30-04-2017

(A) Hyper Text Transfer Protocol

(B) Hyper	Text	Transformation	Protocol

(C) Hyper	Text	Translation	Protocol

(D) Hyper Text Timeline Protocol

11. ¼khík{kt çkLku÷ «Úk{ fBÃÞqxhLkwt Lkk{ þwt níkwt ?
økúk{Ãkt[kÞík Mku¢uxhe (ík÷kxe f{ {tºke (ðøko 3)), Mkwhík rsÕ÷ku, 06-06-2015

(A) WòMk (B) rMkØkÚko
(C) «fkþ (D) hðeLÿ

12. rðLzkuÍ ykuÃkhu®xøk rMkMx{{kt £e [ux fhðk {kxu fÞwt Mkku^xðuh
WÃk÷çÄ Au ? nuz õ÷kfo / ‚{ks fÕÞký r™heûkf …heûkk, 30-04-2017

(A) Windows Chat (B) Windows Conference

(C) Windows Messenger (D) Windows Outlook

13. Outlook Express fÞk «fkhLkku «kuøkúk{ Au ?
nuz õ÷kfo / ‚{ks fÕÞký r™heûkf …heûkk, 30-04-2017

(A) E-{uR÷ õ÷kÞLx (B) Mkðoh õ÷kÞLx
(C) çkúkW®Íøk õ÷kÞLx (D) rMkMx{ õ÷kÞLx

14. {kR¢kuMkku^x rðLzkuÍ{kt ÃkqðorLkÄkorhík heíku fÞwt ðuçk çkúkWÍh WÃk÷çÄ
çkLku Au ? …uxk rn‚kƒ™eþ / ‚ƒ-ykurzxh (ð„o 3), 11-06-2017

(A) Internet Explorer (B) Windows Explorer

(C) Google Chrome (D) Mozilla Firefox

15. <b> rMkðkÞ yLÞ fE xuøk ðzu yûkhkuLku HTML{kt çkkuÕz fhe þfkÞ
Au ? …uxk rn‚kƒ™eþ / ‚ƒ-ykurzxh (ð„o 3), 11-06-2017

(A) <bold>

(B) <strong>

(C) <emp>

(D) (A), (B), (C) Ãkife yufÃký Lknª.

16. DBMS{kt Savepoint ykËuþ ........... {kt rLkrník ÚkkÞ Au.
…uxk rn‚kƒ™eþ / ‚ƒ-ykurzxh (ð„o 3), 11-06-2017

(A) ACL

(B) TCL

(C) DCL

(D) (A), (B), (C) Ãkife yufÃký Lknª.

17. HTML ËMíkkðuòu (document) Lku yk «fkhÚke Mktr[ík (save) fhkÞ Au.
…uxk rn‚kƒ™eþ / ‚ƒ-ykurzxh (ð„o 3), 11-06-2017

(A) rðrþü rîytfe MðYÃk
(B) Þtºk ¼k»kk Mktfuíkku
(C) ASCII yûkh
(D) (A), (B), (C) Ãkife yufÃký Lknª.

18. E-{uR÷Lke Mkuðk ykÃkíke MktMÚkkLkk Lkk{Lku þwt fnu Au?
…uxk rn‚kƒ™eþ / ‚ƒ-ykurzxh (ð„o 3), 11-06-2017

(A) {uR÷ Lku{ (B) nkuMx Lku{
(C) zku{uRLk Lku{ (D) MkŠðMk Lku{

19. fkuüf (table) Lke h[Lkk çkË÷ðk fÞku SQL ykËuþ ðÃkhkÞ Au?
…uxk rn‚kƒ™eþ / ‚ƒ-ykurzxh (ð„o 3), 11-06-2017

(A) UPDATE (B) ALTER

(C) CHANGE (D) (A), (B), (C) ík{k{

1. (D) 2. (B) 3. (B) 4. (D) 5. (A) 6. (B) 7. (B) 8. (D) 9. (A) 10. (A)
11. (B) 12. (C) 13. (A) 14. (A) 15. (B) 16. (B) 17. (C) 18. (B) 19. (B)
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20. fBÃÞqxh{kt ÃkqðorLkÄkorhík heíku VkuÕzh fÞk htøkLkwt òuðk {¤u Au?
r‚r™Þh Wãku„ r™heûkf (ð„o 3), 07-05-2017

(A) MkVuË (B) fk¤k
(C) Ãke¤k (D) ðkË¤e

21. CD-ROM stands for? r‚r™Þh Wãku„ r™heûkf (ð„o 3), 07-05-2017

(A) Compactable Read Only Memory

(B) Compact Data Read Only Memory

(C) Compactable Disk Read Only Memory

(D) Compact Disk Read Only Memory

22. Header	files	often	have	 the	file	extension
r‚r™Þh Wãku„ r™heûkf (ð„o 3), 07-05-2017

(A) .h (B) .he (C) .head (D) .c

23. E-{uR÷ yuzÙuMk{kt ÞwÍhLku{ ÃkAe fÞwt r[nTLk {qfðk{kt ykðu Au?
r‚r™Þh Wãku„ r™heûkf (ð„o 3), 07-05-2017

(A) @ (B) . (C) $ (D) *

24. fBÃÞqxh çktÄ fhíkkt þu{ktÚke {krníke Lkkþ Ãkk{u Au ?
Mk{ks fÕÞký rLkheûkf (ð„o 3), 28-01-2017

(A) VCD (B) RAM (C) ROM (D) CD

25. Lke[uLkk{ktÚke fÞk «fkhLke {u{heLku Võík ðkt[e þfkÞ Au ?
{ËË™eþ ykrËòrŒ rðfk‚ yrÄfkhe (ð„o 3), 18-12-2016

(A) RAM (B) ROM

(C) (A) yLku (B) çktLku (D) ykÃku÷ Ãkife yufÃký Lknª.

26. Lke[uLkk{ktÚke yuf økúkrVõMkLkku «fkh Au íku sýkðku.
{ËË™eþ ykrËòrŒ rðfk‚ yrÄfkhe (ð„o 3), 18-12-2016

(A) Photo (B) Raster

(C) Clipart (D) Pit

27. SMPSLkwt Ãkqhwt Lkk{ þwt Au ?
rçkLk-Mkr[ðk÷Þ fkhfwLk yLku Mkr[ðk÷Þ ykurVMk ykrMkMxLx, 16-10-2016

(A) Switched Model Power Supply

(B) Switched Markup Power Supply

(C) Switched Mode Power Supply

(D) Switched Modular Power Supply

28. fkuE Ãký VkR÷ fu VkuÕzhLkwt Lkk{ çkË÷ðk {kxu íkuLkk Ãkh hkRx
Âõ÷f fhe fÞku rðfÕÃk ÃkMktË fhðk{kt ykðu Au ?

rçkLk-Mkr[ðk÷Þ fkhfwLk yLku Mkr[ðk÷Þ ykurVMk ykrMkMxLx, 16-10-2016

(A) Change (B) Modify

(C) Rename (D) Edit

29. MS Word{kt ÃkusLku Q¼wt Ëþkoððk {kxu fÞk rðfÕÃkLkku WÃkÞkuøk
fhðk{kt ykðu Au ?

rçkLk-Mkr[ðk÷Þ fkhfwLk yLku Mkr[ðk÷Þ ykurVMk ykrMkMxLx, 16-10-2016

(A) Landscape (B) Portrait

(C) Column (D) Row

30. MS Word{kt ÷¾kýLkk VkuLxLku {kuxk fhðk {kxu fÞk rðfÕÃkLkku
WÃkÞkuøk fhþku ?

rçkLk-Mkr[ðk÷Þ fkhfwLk yLku Mkr[ðk÷Þ ykurVMk ykrMkMxLx, 16-10-2016

(A) Ctrl + Alt + ‘+’ (B) Ctrl	+	Shift	+	 ‘+’

(C) Ctrl + Alt + ‘>’ (D) Ctrl	+	Shift	+	>

31. yuf ðuçkMkkRx ÃkhÚke yLÞ ðuçkMkkRx Ãkh sðkLke «r¢ÞkLke þwt fnu
Au ? rçkLk-Mkr[ðk÷Þ fkhfwLk yLku Mkr[ðk÷Þ ykurVMk ykrMkMxLx, 16-10-2016

(A) Mk‹Vøk (B) Mk‹[øk
(C) {q®ðøk (D) VkR®Lzøk

32. abc@gmail.com{kt abc þwt Au ?
rçkLk-Mkr[ðk÷Þ fkhfwLk yLku Mkr[ðk÷Þ ykurVMk ykrMkMxLx, 16-10-2016

(A) yufTMxuLþLk (B) MkŠðMk «kuðkRzh
(C) nkuMx Lku{ (D) ÞwÍh Lku{

33. LANLkwt Ãkqhwt Lkk{ þwt Au ?
rçkLk-Mkr[ðk÷Þ fkhfwLk yLku Mkr[ðk÷Þ ykurVMk ykrMkMxLx, 16-10-2016

(A) Logged Area Network (B) Login Area Network

(C) Local Area Network (D) Locking Area Network

34. {kWMkLkk çkxLkLku çku ð¾ík ËçkkðeLku Akuze ËuðkLke «r¢ÞkLku þwt fnu
Au ? rçkLk-Mkr[ðk÷Þ fkhfwLk yLku Mkr[ðk÷Þ ykurVMk ykrMkMxLx, 16-10-2016

(A) Âõ÷f (B) zçk÷ Âõ÷f
(C) zÙu®økøk (D) hkRx Âõ÷f

35. MS Word {kt Regular Italics Bold ðøkuhu þwt Au?
{ËËLkeþ Mk{ks fÕÞký yrÄfkhe (ð„o 3), 27-05-2018

(A) Font (B) Effect

(C) Font style (D) Font Type

36. Mkk{kLÞ heíku CDLke Mktøkún ûk{íkk fux÷e nkuÞ Au ?
rçkLk-Mkr[ðk÷Þ fkhfwLk yLku Mkr[ðk÷Þ ykurVMk ykrMkMxLx, 16-10-2016

(A) 500 MB (B) 600 MB

(C) 700 MB (D) 800 MB

37. CD/DVD{kt zuxk fÞk MðYÃku Mktøkúrník nkuÞ Au ?
rçkLk-Mkr[ðk÷Þ fkhfwLk yLku Mkr[ðk÷Þ ykurVMk ykrMkMxLx, 16-10-2016

(A) Analog

(B) Digital

(C) (A) yLku (B) çktLku
(D) (A) yLku (B) Ãkife yuf Ãký Lknª.

38. MS	Office Ãkufus{kt fÞk «kuøkúk{Lkku Mk{kðuþ Úkíkku LkÚke ?
rçkLk-Mkr[ðk÷Þ fkhfwLk yLku Mkr[ðk÷Þ ykurVMk ykrMkMxLx, 16-10-2016

(A) Word (B) Excel (C) Writer (D) Access

39. fkuE Mkku^xðuhLke sqLke ykð]r¥kLkk MÚkkLku íkuLke Lkðe yãíkLk
ykð]r¥k W{uhðkLke «r¢ÞkLku þwt fnu Au ?

rçkLk-Mkr[ðk÷Þ fkhfwLk yLku Mkr[ðk÷Þ ykurVMk ykrMkMxLx, 16-10-2016

(A) Mxkuh (B) rhMxkuh
(C) yÃkøkúuz (D) çkufyÃk

40. Lkðwt VkuÕzh çkLkkðíkkt ÃkqðorLkÄkorhík heíku íkuLku fÞwt Lkk{ ykÃkðk{kt
ykðu Au? rçkLk-Mkr[ðk÷Þ fkhfwLk yLku Mkr[ðk÷Þ ykurVMk ykrMkMxLx, 16-10-2016

(A) Untitled	Folder (B) New Folder

(C) Blank Folder (D) Win Folder

41. MS Word{kt VkuLx yLku VkuLx MkkRÍ çkË÷ðk {kxu fÞk xq÷çkkhLkku
WÃkÞkuøk fhðk{kt ykðu Au ?

rçkLk-Mkr[ðk÷Þ fkhfwLk yLku Mkr[ðk÷Þ ykurVMk ykrMkMxLx, 16-10-2016

(A) MxkLzzo xq÷çkkh (B) Vku{uo®xøk xq÷çkkh
(C) VkuLx xq÷çkkh (D) xufMx xq÷çkkh

20. (C) 21. (D) 22. (A) 23. (A) 24. (B) 25. (B) 26. (B) 27. (C) 28. (C) 29. (B)
30. (D) 31. (A) 32. (D) 33. (C) 34. (B) 35. (C) 36. (C) 37. (B) 38. (C) 39. (C)
40. (B) 41. (B)

fBÃÞqxh
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42. Lke[uLkk{ktÚke fÞku rðfÕÃk E-{u÷ f÷kÞLxLkwt WËknhý Ëþkoðu Au ?
rçkLk-Mkr[ðk÷Þ fkhfwLk yLku Mkr[ðk÷Þ ykurVMk ykrMkMxLx, 16-10-2016

(A) Internet Express (B) Outlook Express

(C) Web Express (D) Email Express

43. E-{u÷ yuzÙuMk{kt nkuMx Lku{ ÃkAe fÌkwt r[nTLk {qfðk{kt ykðu Au?
rçkLk-Mkr[ðk÷Þ fkhfwLk yLku Mkr[ðk÷Þ ykurVMk ykrMkMxLx, 16-10-2016

(A) @ (B) . (C) S (D) *

44. fe-çkkuzo{kt Delete fe «uMk fhðkÚke fMkohLke fE çkkswLkk yûkh Ëqh
Úkþu ? rçkLk-Mkr[ðk÷Þ fkhfwLk yLku Mkr[ðk÷Þ ykurVMk ykrMkMxLx, 16-10-2016

(A) zkçke (B) s{ýe
(C) WÃkh (D) Lke[u

45. Lke[uLkk{ktÚke fÞwt ykWxÃkwx rzðkRMk LkÚke ? õ÷kfo, íkk. 16-9-2018

(A) xÙufçkku÷ (B) MÃkefh
(C) r«Lxh (D) Ã÷kuxh

46. fBÃÞqxh{kt yuf yûkhLkku Mktøkún fhðk {kxu fux÷k çkexLkku WÃkÞkuøk
fhðk{kt ykðu Au ?

rçkLk-Mkr[ðk÷Þ fkhfwLk yLku Mkr[ðk÷Þ ykurVMk ykrMkMxLx, 16-10-2016

(A) 1 (B) 4 (C) 8 (D) 16

47. Lke[uLkk{ktÚke fE MkwrðÄkLkku WÃkÞkuøk fheLku fBÃÞqxh{kt hnu÷e
xuBÃkhhe VkR÷Lku Ëqh fhe þfkÞ Au ?

rçkLk-Mkr[ðk÷Þ fkhfwLk yLku Mkr[ðk÷Þ ykurVMk ykrMkMxLx, 16-10-2016

(A) Disk Cleanup (B) Clean Disk

(C) Disk Eraser (D) Disk Clear

48. Lke[uLkk{ktÚke fE {kuçkkR÷ ykuÃkhu®xøk rMkMx{ Au ?
ykurVMk MkwÃkrhLxuLzuLx, 03-07-2016

(A) yuLzÙkuEz (B) ðzo
(C) yuõMkuMk (D) yuLxÙkuz

49. ðuçkçkúkWÍhLkk ¼køk íkhefu Mkh¤íkkÚke «MÚkkrÃkík fheLku WÃkÞkuøk{kt
÷E þfkÞ íkuðk MknkÞf «kuøkúk{Lku þwt fnu Au ?

ykurVMk MkwÃkrhLxuLzuLx, 03-07-2016

(A) Video (B) Picture (C) Plug-in (D) Text

50. fBÃÞqxh{kt Lkðk VkuLxLku Ëk¾÷ fhðk {kxu fÞk ykuÃþLkLkku WÃkÞkuøk
fhðk{kt ykðu Au ? ykurVMk MkwÃkrhLxuLzuLx, 03-07-2016

(A) yuMkuMkheÍ (B) ftxÙku÷ ÃkuLk÷
(C) ðzo (D) yufuÞ Lknª

51. MS Excel ËMíkkðusLku þwt fnu Au ? ykurVMk MkwÃkrhLxuLzuLx, 03-07-2016

(A) M«uzþex (B) zkìõÞw{uLx
(C) M÷kRz (D) xuçk÷

52. yufMkuMk{kt çkLkkðu÷ VkR÷Lkwt yuõMxuLþLk þwt nkuÞ Au ?
ykurVMk MkwÃkrhLxuLzuLx, 03-07-2016

(A) .MDB (B) .MBD (C) .MDD (D) .MBB

53. WçkLxw r÷Lkûk{kt [k÷w {kMkLkwt fu÷uLzh òuðk fÞk f{kLzLkku WÃkÞkuøk
ÚkkÞ Au ? ykurVMk MkwÃkrhLxuLzuLx, 03-07-2016

(A) $CAL (B) $KAL

(C) MONTH (D) yufuÞ Lknª

54. MS Word{kt xkRÃk fhu÷e {krníke{kt MkwÄkhk-ðÄkhk fhðkLke «r¢ÞkLku
þwt fnu Au ? rMkrLkÞh õ÷kfo (ðøko 3), 26-06-2016

(A) Inserting (B) Editing

(C) Deleting (D) Writing

55. Lke[uLkk{ktÚke yuf ykuÃþLk yuMkuMkheÍ Lkk{Lkk økúqÃk{kt òuðk {¤íkwt
LkÚke ? rMkrLkÞh õ÷kfo (ðøko 3), 26-06-2016

(A) Publishers (B) Control Panel

(C) Paint (D) Notepad

56. íkMkðehkuLku rzrsx÷ MðYÃk{kt YÃkktíkrhík fhðk fÞk MkkÄLkLkku WÃkÞkuøk
fhðk{kt ykðu Au ? rMkrLkÞh õ÷kfo (ðøko 3), 26-06-2016

(A) {kurLkxh (B) MfuLkh
(C) r«Lxh (D) nkzo rzMf

57. Lke[uLkk{ktÚke fÞwt ykuÃkLk ðuçk MkðohLkwt WËknhý Au ?
rMkrLkÞh õ÷kfo (ðøko 3), 26-06-2016

(A) WINDOWS (B) APACHE

(C) APPLE (D) yufuÞ Lknª

58. MS Word VkR÷Lkwt yuõMxuLþLk þwt nkuÞ Au ?
rnMkkçkLkeþ/ykurzxh/Ãkuxk-ríkòuhe yrÄfkhe/yrÄûkf (ðøko 3), 12-06-2016

(A) .wrt (B) .doc

(C) .wrd (D) .dac

59. ðzo «kuMkuMkh íkhefu fE yuÂÃ÷fuþLkLku yku¤¾ðk{kt ykðu Au?
rnMkkçkLkeþ/ykurzxh/Ãkuxk-ríkòuhe yrÄfkhe/yrÄûkf (ðøko 3), 12-06-2016

(A) WORD (B) HTML

(C) EXCEL (D) yufuÞ Lknª

60. Lke[uLkk{ktÚke fE yuÂÃ÷fuþLkLkku Mk{kðuþ ACCESSORIES Lkk{Lkk økúqÃk{kt
ÚkÞu÷ Au? rnMkkçkLkeþ/ykurzxh/Ãkuxk-ríkòuhe yrÄfkhe/yrÄûkf (ðøko 3), 12-06-2016

(A) CALCULATOR (B) WORD

(C) EXCEL (D) yufuÞ Lknª

61. Lke[uLkk{ktLkwt yuf {erzÞk Ã÷uÞh LkÚke íku sýkðku.
rnMkkçkLkeþ/ykurzxh/Ãkuxk-ríkòuhe yrÄfkhe/yrÄûkf (ðøko 3), 12-06-2016

(A) VLC Media Player (B) Windows Media Player

(C) Word Media Player (D) Flash Player

62. MS PowerPoint {kt fkuE [ku¬Mk M÷kRzLku Mktíkkzðk {kxu fÞk {uLkq-
rðfÕÃkLkku WÃkÞkuøk fhðk{kt ykðu Au ?

{nuMkq÷e ík÷kxe, Section-A, 28-02-2016

(A) Tools → Hide Slide (B) View → Hide Slide

(C) Format → Hide Slide (D) Slide Show → Hide Slide

63. çknku¤k «{ký{kt ðÃkhkíkwt fBÃÞqxhLkwt RLkÃkwx rzðkRMk fÞwt ?
õ÷kfo, íkk. 16-9-2018

(A) {kWMk (B) {kuzu{
(C) {kurLkxh (D) fe çkkuzo

64. HTML{kt çkLkkðu÷ VkR÷Lkwt ykWxÃkwx òuðk {kxu þuLkku WÃkÞkuøk
ÚkkÞ Au ? Ãkuxk-rnMkkçkLkeþ/Mkçk-ykurzxh, 13-09-2015

(A) WORD (B) WS

(C) WEB BROWSER (D) yufuÞ Lknª.

42. (B) 43. (B) 44. (B) 45. (A) 46. (C) 47. (A) 48. (A) 49. (C) 50. (B) 51. (A)
52. (A) 53. (A) 54. (B) 55. (A/B) 56. (B) 57. (B) 58. (B) 59. (A) 60. (A) 61. (C)
62. (D) 63. (D) 64. (C)
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65. MS Excel{kt {krníkeLku [Zíkk fu Qíkhíkk ¢{{kt økkuXððk {kxuLkku Sort

rðfÕÃk fÞk {uLkq{kt òuðk {¤u Au ?
Ãkuxk-rnMkkçkLkeþ/Mkçk-ykurzxh, 13-09-2015

(A) File (B) Sort

(C) Data (D) Tools

66. HTML{kt ykze ÷kRLk Ëkuhðk {kxu fÞk xuøkLkku WÃkÞkuøk ÚkkÞ Au ?
Ãkuxk-rnMkkçkLkeþ/Mkçk-ykurzxh, 13-09-2015

(A) HR (B) BR

(C) AR (D) CR

67. Lkuxðfo{kt hnu÷kt fBÃÞqxhLku ykÃkðk{kt ykðíkkt yòuz Lkk{Lku þwt
fnu Au ? Ãkuxk-rnMkkçkLkeþ/Mkçk-ykurzxh, 13-09-2015

(A) INS yuzÙuMk (B) IP yuzÙuMk
(C) IMS yuzÙuMk (D) IS yuzÙuMk

68. MS Word {kt Page Setup Lkk Margins nuX¤ fÞku rðfÕÃk òuðk {¤íkku
LkÚke? {ËËLkeþ Mk{ks fÕÞký yrÄfkhe (ð„o 3), 27-05-2018

(A) Left (B) Right

(C) Center (D) Top

69. ðuçkÃkus çkLkkððk {kxu fE ¼k»kkLkku WÃkÞkuøk fhðk{kt ykðu Au?
Ãkuxk-rnMkkçkLkeþ/Mkçk-ykurzxh, 13-09-2015

(A) C (B) HTML

(C) Visual Basic (D) HTTP

70. Lke[uLkk{ktÚke fÞku rðfÕÃk LkuxðfoLkku «fkh Ëþkoðu Au ?
Ãkuxk-rnMkkçkLkeþ/Mkçk-ykurzxh, 13-09-2015

(A) LAN (B) MAN

(C) WAN (D) ykÃku÷ ík{k{

71. økwshkík Mxux Ãkkuxo÷ fÞwt Au ? ykurVMk ykrMkMxLx (ð„o 3), 04-01-2015

(A) www.gujarat.com (B) www.gujaratindia.com

(C) www.gujaratstate.com (D) www.gujaratgout.in

72. ykuLk÷kRLk òuçk yuÂÃ÷fuþLk rMkMx{ (OJAS) Ãkh Lkkufhe {kxu yhS
fhíke ð¾íku fÞwt rVÕz yuLxh fhðwt VhrsÞkík LkÚke?

ykurVMk ykrMkMxLx (ð„o 3), 04-01-2015

(1) {kíkkLkwt Lkk{
(2) nk÷Lkwt MkhLkk{wt
(3) E-{uR÷ yuzÙuMk
(4) {kuçkkR÷ Lktçkh
(A) 1 (B) 3

(C) 1 yLku 4 (D) 2 yLku 4

73. r÷Lkûk{kt þçË økýðk {kxu fÞk f{kLzLkku WÃkÞkuøk ÚkkÞ Au?
«kuçkuþLkhe ykurVMkh (ð„o 3), 04-09-2016

(A) WLC (B) WC

(C) WLL (D) WCC

74. DBMSLkwt Ãkqhwt Lkk{ þwt Au ? «kuçkuþLkhe ykurVMkh (ð„o 3), 04-09-2016

(A) zuxkçkuÍ {uLkus{uLx rMkMx{
(B) zuxkçkuÍ r{rLk{kEÍ rMkMx{
(C) zuxkçkuÍ {uLkus{uLx rMkõÞkurhxe
(D) zuxkçkuÍ {uÂõMk{{ rMkMx{

75. MS Word{kt ÃkuhuøkúkVLkku «Úk{ yûkh {kuxku Ëþkoððk {kxu fE
MkwrðÄkLkku WÃkÞkuøk fhðk{kt ykðu Au?

{ËËLkeþ Mk{ks fÕÞký yrÄfkhe (ð„o 3), 27-05-2018

(A) Big Caps (B) Top Caps

(C) Master Caps (D) Drop Caps

76. fBÃÞqxhLke MÃkez þu{kt {ÃkkÞ Au ? swrLkÞh ykrMkMxLx, 06-03-2016

(A) MPIS (B) MSIP

(C) MIPS (D) yufuÞ Lknª

77. fBÃÞqxh{kt ðÃkhkíke JPEG VkR÷Lkwt Ãkqhtw Lkk{ sýkðku.
swrLkÞh ykrMkMxLx, 06-03-2016

(A) Joint Photography Expert Group

(B) Joint Photographic Expert’s Group

(C) Joint Photograph Expert’s Group

(D) Joint Photographic Experts Group

78. ykuÃkLk MkkuMko {kxu ftE ykuÃkhu®xøk rMkMx{ òýeíke Au ?
swrLkÞh ykrMkMxLx, 06-03-2016

(A) rðLzkuÍ (B) {ufLxkuþ
(C) ÷eLkûk (D) yufuÞ Lknª

79. Lke[uLkk{ktÚke fÞwt MkkuVxðuh økúkrVfMk íkhefu yku¤¾kÞ Au ?
ykurVMk MkwÃkrhLxuLzuLx, 04-10-2015

(A) CORELDRAW (B) EXCEL

(C) POWERPOINT (D) yufuÞ Lknª

80. þuLke MknkÞÚke yLÞºk hnu÷ íks¿kLku òuE fu Mkkt¼¤e þfeyu Aeyu ?
ykurVMk MkwÃkrhLxuLzuLx, 04-10-2015

(A) sLkkor÷Mx (B) ðerzÞku-fkuLVh®LMkøk
(C) r[ºk (D) Vezçkuf

81. GTU : yux÷u ? ykurVMk MkwÃkrhLxuLzuLx, 04-10-2015

(A) Gujarat Technology University (B) Gujarat Transport University

(C) Gujarat Technology Union (D) yuf Ãký Lknª

82. WçkLxw r÷Lkûk{kt mv f{kLz Lke[uLkk Ãkife fÞk nuíkw {kxu WÃkÞkuøk{kt
÷uðkÞ Au ? ykurVMk MkwÃkrhLxuLzuLx, 04-10-2015

(A) VkR÷Lku yLÞºk ¾Mkuzðk (B) VkR÷Lke Lkf÷ fhðk
(C) rzhufxheLkwt Lkk{ çkË÷ðk (D) WÃkhLkk çkÄk

83. Lke[uLkk{ktÚke fÞk MkkuVxðuhLkku yurLk{uþLk íkhefu WÃkÞkuøk ÚkkÞ Au ?
ykurVMk MkwÃkrhLxuLzuLx, 04-10-2015

(A) EXCEL (B) MAYA

(C) WORD (D) yufuÞ Lkrn

84. IDE Lkwt Ãkqhtw Lkk{ sýkðku. ykurVMk MkwÃkrhLxuLzuLx, 04-10-2015

(A) Integrated Details Entry

(B) Integrated Development Environment

(C) Institute	of	Details	Environment

(D) Institute	Details	Entry

85. SQL Lkwt Ãkqhtw Lkk{ þwt Au ? ykurVMk MkwÃkrhLxuLzuLx, 04-10-2015

(A) Structured Que Line

(B) Structured Query Language

(C) System Querh Line

(D) Structured Query for Large Command

65. (C) 66. (A) 67. (B) 68. (C) 69. (B) 70. (D) 71. (B) 72. (B) 73. (B) 74. (A)
75. (D) 76. (C) 77. (D) 78. (C) 79. (A) 80. (B) 81. (D) 82. (D) 83. (B) 84. (B)
85. (B)
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86. ¼khík Ëuþu rðïLku fÞk fBÃÞqxhLke ¼ux Ähe níke ?
ykurVMk MkwÃkrhLxuLzuLx, 04-10-2015

(A) MINI (B) MICRO

(C) SUPER (D) yufuÞ Lkrn

87. Lke[uLkk{ktÚke fÞku zuxkçkuÍ «kuøkúk{ LkÚke ?
ykurVMk MkwÃkrhLxuLzuLx, 04-10-2015

(A) ðzo (B) yuMkõÞwyu÷ Mkðoh
(C) {kÞ yuMkõÞwyu÷ (D) çkuÍ

88. fBÃÞqxh {kurLkxhLku ............... Ãký fnuðkÞ Au.
Ãkku÷eMk Mkçk-RLMÃkuõxh, «§Ãkºk-3 : Mkk{kLÞ ¿kkLk, 04-03-2017

(A) DVU (B) VDU

(C) UVD (D) CCTV

89. fBÃÞqxhLke {ì{heLkk yuf{Lku [Zíkk ¢{{kt økkuXðku :
Ãkku÷eMk Mkçk-RLMÃkuõxh, «§Ãkºk-3 : Mkk{kLÞ ¿kkLk, 04-03-2017

(A) TB > MB > GB > KB (B) MB > GB > TB > KB

(C) TB > GB > MB > KB (D) GB > MB > KB > TB

90. Lke[uLkk{ktÚke fÞwt Mkk[wt LkÚke ?
Ãkku÷eMk Mkçk-RLMÃkuõxh, «§Ãkºk-3 : Mkk{kLÞ ¿kkLk, 04-03-2017

(A) rzr÷x fhu÷e VkR÷ rhMkkRf÷ rçkLk{kt {¤u Au.
(B) rhMkkRf÷ rçkLk{ktÚke fkuE Ãký VkR÷Lku rhMxkuh fhe þfkÞ Au.
(C) VkR÷kuLku rhMkkRf÷ rçkLk{kt {kuf÷e rzMfLke £e MÃkuMk ðÄkhe

þfkÞ Au.
(D) Right Click ËçkkðeLku “empty recycle bin” [ÞLk fhíkkt yuf

ðkh{kt íku õ÷eÞh ÚkE òÞ Au.

91. Lke[uLkk{ktÚke fÞku yuÂÃ÷fuþLk Mkku^xðuh LkÚke ?
Ãkku÷eMk Mkçk-RLMÃkuõxh, «§Ãkºk-3 : Mkk{kLÞ ¿kkLk, 04-03-2017

(A) rðLzkuÍ NT (B) Ãkus{ufh
(C) rðLzkuÍ XP (D) VkuxkuþkuÃk

92. fÞku «kuøkúk{ {kuxe VkR÷Lku LkkLke VkR÷{kt fB«uMk fhe Lkk¾u Au.
Ãkku÷eMk Mkçk-RLMÃkuõxh, «§Ãkºk-3 : Mkk{kLÞ ¿kkLk, 04-03-2017

(A) Winzip (B) Winspread

(C) Winstyle (D) Winmicro

93. Lke[uLkk{ktÚke fE ykìÃkhu®xøk rMkMx{ LkÚke ?
Ãkku÷eMk Mkçk-RLMÃkuõxh, «§Ãkºk-3 : Mkk{kLÞ ¿kkLk, 04-03-2017

(A) DOC (B) Linux

(C) Windows (D) Oracle

94. rhMkkRf÷ rçkLk{kt VkR÷Lkku Mktøkún fÞko rðLkk fuðe heíku rzr÷x fhe
þfkÞ Au ? Ãkku÷eMk Mkçk-RLMÃkuõxh, «§Ãkºk-3 : Mkk{kLÞ ¿kkLk, 04-03-2017

(A) Press Delete key (B) Press	Shift	+	Delete	key

(C) Press Ctrl + Delete key (D) Press Alt + Delete key

95. Virtual memory Mkk{kLÞ heíku ............{kt ÂMÚkík nkuÞ Au.
Ãkku÷eMk Mkçk-RLMÃkuõxh, «§Ãkºk-3 : Mkk{kLÞ ¿kkLk, 04-03-2017

(A) RAM (B) CPU

(C) Flash card (D) Hard Drive

96. ík{u {kWMkLkwt Mku®xøk õÞktÚke çkË÷e þfku Aku ?
Ãkku÷eMk Mkçk-RLMÃkuõxh, «§Ãkºk-3 : Mkk{kLÞ ¿kkLk, 04-03-2017

(A) Setting	>>	mouse (B) Hardware	 setting

(C) Control Panel >> mouse (D) yk ºký{ktÚke yuf Ãký Lknª

97. RLxhLkux yuõMkÃ÷kuhh :
Ãkku÷eMk Mkçk-RLMÃkuõxh, «§Ãkºk-3 : Mkk{kLÞ ¿kkLk, 04-03-2017

(A) íku yuf RLxhLkux çkúkWÍh Au.
(B) íkuLku rðLzkuÍ OS WÃk÷çÄ fhkðu Au.
(C) ðÕzoðkRz ðuçk {kxu yuõMkuMk ÃkkìRLx Au.
(D) ykÃku÷k ík{k{

98. Mkr¢Þ rðLzkuLku çktÄ fhðk {kxu ðÃkhkíke fe fE Au ?
Ãkku÷eMk Mkçk-RLMÃkuõxh, «§Ãkºk-3 : Mkk{kLÞ ¿kkLk, 04-03-2017

(A) Ctrl + F4 (B) Ctrl + F5

(C) Alt + F6 (D) Alt + F7

99. LkkuxÃkuzLkwt rzVkìÕx VkR÷ yuõMkxuLþLk þwt Au ?
Ãkku÷eMk Mkçk-RLMÃkuõxh, «§Ãkºk-3 : Mkk{kLÞ ¿kkLk, 04-03-2017

(A) .doc (B) .html

(C) .txt (D) .tif

100. MS Window ykìÃkhu®xøk rMkMx{Lkku ykht¼ õÞkhu ÚkÞku níkku?
Ãkku÷eMk Mkçk-RLMÃkuõxh, «§Ãkºk-3 : Mkk{kLÞ ¿kkLk, 04-03-2017

(A) 1975 (B) 1985

(C) 1995 (D) 2000

101. 1024 çkexTMk = ........... Ãkku÷eMk fkuLMxuçk÷ íkÚkk su÷ rMkÃkkne, 23-10-2016

(A) 1 KB (B) 1 MB

(C) 1 TB (D) yuf 5ý Lknª.

102. WANLktw Ãkqhwt Lkk{ ÷¾ku. Ãkku÷eMk fkuLMxuçk÷ íkÚkk su÷ rMkÃkkne, 23-10-2016

(A) Wireless Are Network (B) Wall Area Network

(C) Wide Area Network (D) Wi-Fi Area Network

103. Lke[uLkk{ktÚke fÞku rðfÕÃk RLxhLkux MkkÚku MktçktrÄík Au ?
Ãkku÷eMk fkuLMxuçk÷ íkÚkk su÷ rMkÃkkne, 23-10-2016

(A) URL (B) DMP

(C) BPM (D) URK

104. Lke[uLkk{ktÚke fÞku rðfÕÃk RLxhLkux þkuÄ yuÂLsLk LkÚke ?
Ãkku÷eMk fkuLMxuçk÷ íkÚkk su÷ rMkÃkkne, 23-10-2016

(A) Google (B) Yahoo

(C) Bing (D) King

105. E-{u÷{kt CCLkku yÚko þwt Au ?
Ãkku÷eMk fkuLMxuçk÷ íkÚkk su÷ rMkÃkkne, 23-10-2016

(A) Cut & Copy (B) Copy Case

(C) Carbon Copy (D) yuf Ãký Lknª.

106. ........ yu ykuÃkhu®xøk rMkMx{Lkwt Lkk{ LkÚke.
Ãkku÷eMk fkuLMxuçk÷ íkÚkk su÷ rMkÃkkne, 23-10-2016

(A) Window XP (B) Linux

(C) Ubuntu (D) Apple

107. rðãkÚkeoykuLkkt Lkk{-MkhLkk{kt fBÃÞqxh{kt Mxkuh fhðk {kxu fÞk
Mkku^xðuhLkku WÃkÞkuøk ÚkkÞ ?

Ãkku÷eMk fkuLMxuçk÷ íkÚkk su÷ rMkÃkkne, 23-10-2016

(A) Word (B) Power Point

(C) Write (D) Access

86. (D) 87. (A) 88. (B) 89. (C) 90. (C) 91. (A) 92. (A) 93. (D) 94. (B) 95. (A)
96. (C) 97. (D) 98. (A) 99. (C) 100. (B) 101. (D) 102. (C) 103. (A) 104. (D) 105. (C)

106. (D) 107. (D)
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108. OCRLkwt Ãkqhwt Lkk{..... Ãkku÷eMk fkuLMxuçk÷ íkÚkk su÷ rMkÃkkne, 23-10-2016

(A) ykuÂÃxf÷ fuhuõxh hufÂøLkMkLk
(B) yku÷ fuhuõxh hufÂøLkMkLk
(C) ykuÕz fuhuõxh hufÂøLkMkLk
(D) yuf Ãký Lknª.

109. HTML Lkwt Ãkqhtw Lkk{ þwt Au ? ykurVMk Mkwr«LxuLzuLx, 04-10-2015

(A) Hyper Text Markup Language (B) Hyper Text Management Link

(C) Hyper Test Markup Link (D) yufuÞ Lkrn

110. CPU Lkwt Ãkqhwt Lkk{ þwt Au ? Ãkku÷eMk fkuLMxuçk÷, 03-05-2015

(A) MkuLxÙ÷ «kuMku®Mkøk ÞwrLkx (B) MkuLxÙ÷ ÃkhVufx ÞwrLkx
(C) MkuLxÙ÷ «kusuõx ÞwrLkx (D) MkuLxÙ÷ ÃkÂç÷f ÞwrLkx

111. fBÃÞqxh fÞk çku yktfzkykuLku yku¤¾u Au ?
ík÷kxe-f{-{tºke, 23-08-2015

(A) 9 yLku 10 (B) 1 yLku 11

(C) 0 yLku 1 (D) 1 yLku 100

112. rðrfÃkerzÞk þwt Au ? {ÂÕx ÃkÃkoÍ nuÕÚk ðfoh, økktÄeLkøkh rsÕ÷ku, 06-06-2015

(A) Lkð÷fÚkk
(B) fkÔÞMktøkún
(C) RLxhLkux WÃkh WÃk÷çÄ rðïfkuþ
(D) þçËfkuþ

113. fBÃÞqxh xLko ykuV fhkíkkt Mkuð zuxk õÞkt hnu Au ?
ƒur÷V (ð„o 3), M{]rŒ ykÄkrhŒ, 19-11-2017

(A) «kR{he Mxkuhus rzðkRMk{kt (B) huLz{ yuõ‚u‚ {u{he{kt
(C) ‚ufLzhe Mxkuhus rzðkRMk{kt (D) {Ähçkkuzo{kt

114. Ãkkðh ÃkkuRLx{kt M÷kRz MkkÚku .............. W{uhe þfkÞ Au.
ƒur÷V (ð„o 3), M{]rŒ ykÄkrhŒ, 19-11-2017

(A) yðks (B) ynª ykÃku÷ çkÄk s
(C) Mk{Þ (D) r[ºk

115. Mkr¢Þ rðLzkuLku çktÄ fhðk {kxu fE fe ðÃkhkÞ Au ?
ƒur÷V (ð„o 3), M{]rŒ ykÄkrhŒ, 12-02-2017

(A) Ctrl + F6 (B) Ctrl + F5

(C) Ctrl + F4 (D) Ctrl + F7

116. ßÞkhu «kuøkúk{ nUøk ÚkE økÞku nkuÞ íÞkhu «kuøkúk{ çktÄ fhðk fE 3

fe MkkÚku Ëçkkððk{kt ykðu Au ?
ƒur÷V (ð„o 3), M{]rŒ ykÄkrhŒ, 19-11-2017

(A) Ctrl	+	Shift	+	Del (B) Ctrl + Alt + Del

(C) Ctrl + Alt + End (D) Alt	+	Shift	+	Del

117. {kW‚™e Âõ÷f ƒË÷ðk {kxu fÞk rðfÕ…{kt sðwt …zu ?
ƒur÷V (ð„o 3), M{]rŒ ykÄkrhŒ, 19-11-2017

(A) VkuLx (B) VkR÷
(C) rðLzkuÍ (D) fLxÙku÷ …u™÷

118. …kuRLxh™u þu™k …h ÷E sðkÞ íÞkhu Œu™ku ykfkh nkÚk suðku
ÚkkÞ Au ? ƒur÷V (ð„o 3), M{]rŒ ykÄkrhŒ, 19-11-2017

(A) ÂM¢™ xe… (B) M…u®÷„ yuhh
(C) nkR…h ®÷f (D) „úk{h yuhh

119. xkMfƒkh™e sYh ™k sýkÞ Œku ......... ykuÃþ™ …‚tË fhðwt …zu.                      
ƒur÷V (ð„o 3), M{]rŒ ykÄkrhŒ, 19-11-2017

(A) nkEz Ä xkMfƒkh (B) ykuxku nkEz Ä xkMfƒkh
(C) nkEz (D) ÷kuf Ä xkMfƒkh

120. fBÃÞqxh {kxuLke “ykEMke [eÃMk” Mkk{kLÞ heíku þuLke çkLku÷e nkuÞ Au ?
LkøkhÃkkr÷fk {wÏÞ yrÄfkhe (ð„o 3), 09-04-2017

(A) MkeMkwt (B) rMkr÷fkuLk
(C) íkktçkwt (D) MkkuLkwt

121. [uf WÃkh òuðk {¤íkkt MICR Code Lkwt yk¾wt MðYÃk þwt Au?
LkøkhÃkkr÷fk {wÏÞ yrÄfkhe (ð„o 3), 09-04-2017

(A) Micro	 ink	 character	 recognition

(B) Magnetic	 ink	 credit	 registration

(C) Magnetic	 ink	 character	 recognition

(D) Micro	 ink	 credit	 registration

122. WWW (World Wide Web) Lku ÷kufr«Þ çkLkkðLkkh «Úk{ økúkrVf÷
çkúkWÍh fÞwt níkwt ?

LkkÞçk {k{÷íkËkh íkÚkk LkkÞçk MkufþLk yrÄfkhe, 13-11-2016

(A) VkÞhVkuõMk (B) çkurÍf
(C) yu{yuMk-zkux (D) {kuÍuRf

123. MS Word VkR÷Lke r«Lx ÷uíkkt ð¾íku çkkR®Lzøk MkkRxLke søÞk
Akuzðk {kxu fkuLkku WÃkÞkuøk fhðk{kt ykðu Au?

{ËËLkeþ Mk{ks fÕÞký yrÄfkhe (ð„o 3), 27-05-2018

(A) Left (B) Right

(C) Binder (D) Gutter

124. MS Word{kt VkR÷Lku Save fhðk {kxuLke fux÷e heíkku WÃk÷çÄ Au?
{ËËLkeþ Mk{ks fÕÞký yrÄfkhe (ð„o 3), 27-05-2018

(A) 2 (B) 3 (C) 4 (D) 5

125. VkuÕzhLke ytËh hnu÷k VkuÕzhLku þwt fnu Au?
{ËËLkeþ Mk{ks fÕÞký yrÄfkhe (ð„o 3), 27-05-2018

(A) RLkh VkuÕzh (B) Mkçk VkuÕzh
(C) çkuf VkuÕzh (D) çkurÍf VkuÕzh

126. VkuÕzhLku yLÞ fÞk Lkk{u yku¤¾ðk{kt ykðu Au?
{ËËLkeþ Mk{ks fÕÞký yrÄfkhe (ð„o 3), 27-05-2018

(A) VkR÷ (B) rzhuõxhe
(C) çkuÍ (D) «kuøkúk{

127. Lke[uLkk{ktÚke fÞku rðfÕÃk ðuçk çkúkWÍhLkwt WËknhý Ëþkoðu Au?
{ËËLkeþ Mk{ks fÕÞký yrÄfkhe (ð„o 3), 27-05-2018

(A) Google (B) Gmail

(C) Google Chrome (D) Google Drive

128. RLxhLkux Ãkh WÃk÷çÄ {krníkeLku fBÃÞqxh{kt ÷uðkLke ÃkØríkLku þwt
fnu Au? {ËËLkeþ Mk{ks fÕÞký yrÄfkhe (ð„o 3), 27-05-2018

(A) yÃk÷kuz (B) zkWLk÷kuz
(C) çkufyÃk (D) rhMxkuh

129. ðuçkMkkRxLkk «Úk{ ÃkusLku fÞk Lkk{u yku¤¾ðk{kt ykðu Au?
{ËËLkeþ Mk{ks fÕÞký yrÄfkhe (ð„o 3), 27-05-2018

(A) nku{Ãkus (B) {kMxhÃkus
(C) ðuçkÃkus (D) YxÃkus

108. (A) 109. (A) 110. (A) 111. (C) 112. (C) 113. (C) 114. (B) 115. (C) 116. (B) 117. (D)
118. (C) 119. (B) 120. (B) 121. (C) 122. (D) 123. (D) 124. (B) 125. (B) 126. (B) 127. (C)
128. (B) 129. (A)
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130. yuf ðuçkÃkus ÃkhÚke çkeò ðuçkÃkus Ãkh sðkLke MkwrðÄk fkuý ykÃku Au?
{ËËLkeþ Mk{ks fÕÞký yrÄfkhe (ð„o 3), 27-05-2018

(A) nkRÃkh ®÷f
(B) {kMxh ®÷f
(C) òuRLx ®÷f
(D) fuMfu®zøk ®÷f

131. ðuçkMkkRxLkk yòuz MkhLkk{kLku fÞk Lkk{u yku¤¾ðk{kt ykðu Au?
{ËËLkeþ Mk{ks fÕÞký yrÄfkhe (ð„o 3), 27-05-2018

(A) FTP (B) URL

(C) HTTP (D) ISP

132. RLxhLkux{kt Ëhuf VkR÷ yufçkeò MkkÚku fkuLkk ðzu òuzkÞu÷e nkuÞ Au?
{ËËLkeþ Mk{ks fÕÞký yrÄfkhe (ð„o 3), 27-05-2018

(A) nkRÃkh®÷f (B) {kMxh®÷f
(C) VkR÷®÷f (D) Lkux®÷f

133. abc@gmail.com{kt com þwt Au?
{ËËLkeþ Mk{ks fÕÞký yrÄfkhe (ð„o 3), 27-05-2018

(A) yuõMxuLþLk
(B) MkŠðMk «kuðkRzh
(C) zku{uELk Lku{
(D) ÞwÍhLku{

134. E-{uE÷ yuzÙuMkLke þYykík fkuLkk ðzu fhðk{kt ykðu Au?
{ËËLkeþ Mk{ks fÕÞký yrÄfkhe (ð„o 3), 27-05-2018

(A) ÞwÍhLku{
(B) MkŠðMk «kuðkRzh
(C) nkuMx Lku{
(D) @

135. RAM Lkwt Ãkqhwt Lkk{ þwt Au? nuz fkuLMxuçk÷ (s{kËkh), 20-05-2018

(A) Read Access Memory

(B) Random Access Memory

(C) Real Access Memory

(D) Restore Access Memory

136. MS Word {kt xkRx÷çkkhLke s{ýe çkksw fw÷ fux÷kt ftxÙku÷ çkxLMk
òuðk {¤u Au? yufkWLxLx, 25-03-2018

(A) 3 (B) 4

(C) 5 (D) 6

137. MS Word zkuõÞw{uLxLkk ytík ¼køk{kt sðk {kxu fE þkuxofx feLkku
WÃkÞkuøk fhðk{kt ykðu Au? yufkWLxLx, 25-03-2018

(A) Ctrl + End (B) Alt + Home

(C) Shift	+	Home (D) Tab + Home

138. Lke[uLkk{ktÚke fÞku rðfÕÃk ykìÃkhu®xøk rMkMx{Lkwt WËknhý Ëþkoðu Au ?
yufkWLxLx RLMÃkuõxh (ð„o 3), 25-02-2018

(A) Windows XP (B) Linux

(C) UNIX (D) ykÃku÷ ík{k{

139. MS Word {kt VkuLx MkkRÍLkk zÙkuÃkzkWLk r÷Mx{kt MkkiÚke LkkLke MkkRÍ
fux÷e nkuÞ Au ?    rVÕz ykurVMkh õ÷kMk-3, íkk. 11-3-2018

(A) 1 (B) 4
(C) 8 (D) 10

140. Lke[uLkk{ktÚke fÞku rðfÕÃk zkuõÞw{uLxLkwt ykurhyuLxuþLk Ëþkoðu Au?
rVÕz ykurVMkh õ÷kMk-3, íkk. 11-3-2018

(A) Landscap (B) Portrait

(C) Fixed (D) (A) yLku (B)

141. Lke[uLkk{ktÚke fÞwt yuõMxuLþLk yuÂÃ÷fuþLk «kuøkúk{Lkk VkR÷ Lku{Lkwt
Au  ?                 õ÷kfo, íkk. 16-9-2018

(A) EXE (B) DIR

(C) TXT (D) DOC

142. {krníkeLku ÍzÃkÚke xÙkLMkVh fhðk {kxu fÞku Ãkkuxo WÃkÞkuøke Au?
MkðuoÞh, íkk. 1-4-2018

(A) USP (B) UPS

(C) USB (D) UBS

143. MS Word{kt fE þkuxofx feLkku WÃkÞkuøk fheLku r«Lx r«ÔÞq òuE
þfkÞ Au?        MkðuoÞh, íkk. 1-4-2018

(A) Ctrl + F1 (B) Ctrl + F2

(C) Ctrl + F3 (D) Ctrl + F4

144. MS Word «kuøkúk{Lke çknkh Lkef¤ðk {kxu fE þkuxofx feLkku WÃkÞkuøk
fhþku?             MxkV LkMko (ðøko 3), íkk. 11-3-2018

(A) Alt + F4 (B) Ctrl + F4

(C) Win + F4 (D) Tab + F4

145. MS Word{kt ÃkqðorLkÄkorhík heíku VkR÷Lkwt Lkk{ þwt òuðk {¤u Au?
MxkV LkMko (ðøko 3), íkk. 11-3-2018

(A) Untitled1 (B) Document1

(C) File1 (D) Word1

146. rðLzkuÍ rzr÷x fhu÷e VkR÷kuLku þu{kt Mkq[ðu Au?
MxkV LkMko (ðøko 3), íkk. 11-3-2018

(A) Trash (B) Recycle Bin

(C) Dust Bin (D) Delete Cart

147. çkkÞLkhe ÃkØrík{kt fux÷k ytf nkuÞ Au?  swrLkÞh õ÷kfo, íkk. 25-3-2018

(A) 0 (B) 1

(C) 2 (D) 3

148. CPULkwt MktÃkqýo Lkk{ swrLkÞh õ÷kfo, íkk. 25-3-2018

(A) MkuLxÙ÷ «kuøkúk{ ÞwrLkx (B) MkuLxÙ÷ «kuMku®Mkøk ÞwrLkx
(C) ftxÙku÷ «kuMku®Mkøk ÞwrLkx (D) WÃkhkuõík{ktÚke fkuE Lknª

149. økkrýríkf yLku íkkŠff yuf{Lkwt xqtfwt Lkk{ þwt Au?
swrLkÞh õ÷kfo, íkk. 25-3-2018

(A) MAT (B) ALO

(C) ALP (D) ALU

150. 1 KB = ............. çkkRx. swrLkÞh õ÷kfo, íkk. 25-3-2018

(A) 8 (B) 1024

(C) 1048 (D) WÃkh{ktÚke fkuE Lknª

151. Võík ðkt[e þfkÞ íkuðe {u{heLkwt Lkk{ swrLkÞh õ÷kfo, íkk. 25-3-2018

(A) RAM (B) BAM

(C) ROM (D) CAM

130. (A) 131. (B) 132. (A) 133. (C) 134. (A) 135. (B) 136. (A) 137. (A) 138. (D) 139. (C)
140. (D) 141. (A) 142. (C) 143. (B) 144. (A) 145. (B) 146. (B) 147. (C) 148. (B) 149. (D)
150. (B) 151. (C)
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152. fÞwt ÃkkuR®Lxøk rzðkRMk Au? swrLkÞh õ÷kfo, íkk. 25-3-2018

(A) fe-çkkuzo (B) ykEfkuLk
(C) r«Lxh (D) {kWMk

153. VkR÷ yÚkðk VkuÕzh rzr÷x fÞko ÃkAe fE søÞkyu òÞ Au?
swrLkÞh õ÷kfo, íkk. 25-3-2018

(A) {kÞ fBÃÞqxh (B) zkuõÞw{uLx
(C) rhMkkRf÷ rçkLk (D) WÃkh{ktÚke fkuE Lknª

154. fBÃÞqxhLkk rLkÞtºký {kxu rðLzkuÍLke fE MkøkðzLkku WÃkÞkuøk ÚkkÞ
Au?                      swrLkÞh õ÷kfo, íkk. 25-3-2018

(A) xkMf çkkh (B) fLxÙku÷ ÃkuLk÷
(C) rMkMx{ ÃkuLk÷ (D) WÃkhLkk çkÄk s

155. ykuÃkhu®xøk rMkMx{ yu yuf «fkhLkwt - swrLkÞh õ÷kfo, íkk. 25-3-2018

(A) yuÂÃ÷fuþLk Mkkì^xðuh Au (B) rMkMx{ Mkkì^xðuh Au
(C) nkzoðuh Au (D) (A) yLku (B) çktLku

156. rðLzkuÍ{kt fuÕõÞw÷uxh fÞk rðfÕÃk{kt òuðk {¤u Au?
swrLkÞh õ÷kfo, íkk. 25-3-2018

(A) «kuøkúkBMk (B) yuMkuMkheÍ
(C) fLxÙku÷ ÃkuLk÷ (D) WÃkh{ktÚke yufÃký Lknª

157. Lke[uLkk{ktÚke fÞku rðfÕÃk ykuÃkhu®xøk rMkMx{ Au?
swrLkÞh õ÷kfo, íkk. 25-3-2018

(A) {kR¢kuMkku^x rðLzkuÍ (MS Windows)

(B) r÷Lkûk (Linux)

(C) ÞwrLkõMk (Unix)

(D) WÃkhLkk çkÄk s

158. MS-Paint{kt íkiÞkh ÚkÞu÷ VkR÷Lkwt yuõMxuLþLk þwt nkuÞ Au?
swrLkÞh õ÷kfo, íkk. 25-3-2018

(A) .doc (B) .bmp

(C) .txt (D) WÃkh{ktÚke yufÃký Lknª

159. LkkuxÃkuz{kt Lkðe VkR÷ çkLkkððk {kxuLke þkuxofx fe fE Au?
swrLkÞh õ÷kfo, íkk. 25-3-2018

(A) Ctrl + O (B) Ctrl + N

(C) Ctrl + P (D) Alt + N

160. M¢eLk Âõ÷Þh fhðk {kxu fÞku DOS f{kLz ðÃkhkÞ Au?
swrLkÞh õ÷kfo, íkk. 25-3-2018

(A) Clear (B) Remove

(C) Cls (D) WÃkh{ktÚke yufÃký Lknª

161. rðLzkuLku LkkLke fheLku Mkw»kwÃík yðMÚkk{kt hk¾ðk {kxu fÞk çkxLkLkku
WÃkÞkuøk ÚkkÞ Au?                 swrLkÞh õ÷kfo, íkk. 25-3-2018

(A) õ÷kuÍ (B) rhMxkuh
(C) {uõMke{kRÍ (D) r{rLk{kRÍ

162. VkuÕzh{kt hnu÷k VkuÕzhLku þwt fnuðkÞ Au? swrLkÞh õ÷kfo, íkk. 25-3-2018

(A) çkúkL[ (B) rzhuõxhe
(C) Mkçk rzhuõxhe (D) WÃkh{ktÚke fkuE Lknª

163. MS Office Word{kt íkiÞkh ÚkÞu÷ VkR÷Lkwt yuûxuLþLk þwt nkuÞ Au?
swrLkÞh õ÷kfo, íkk. 25-3-2018

(A) .exe (B) .doc

(C) .xls (D) .ppt

164. VkR÷Lku Save fhðk {kxu fE þkuxo-fx fe ðÃkhkÞ Au?
swrLkÞh õ÷kfo, íkk. 25-3-2018

(A) Ctrl + A (B) Ctrl + S

(C) Ctrl + O (D) Alt + S

165. MS-Word{kt 5uÃkh MkkRÍ çkË÷ðk {kxu fÞk ykuÃþLkLkku WÃkÞkuøk
ÚkkÞ Au ?               swrLkÞh õ÷kfo, íkk. 25-3-2018

(A) Change paper (B) Change size
(C) Paper setup (D) Page setup

166. MS-Word{kt y÷øk y÷øk þu5{kt þçËku fÞk ykuÃþLkÚke ÚkkÞ Au ?
swrLkÞh õ÷kfo, íkk. 25-3-2018

(A) Word Art (B) Clip
(C) File (D) Word Picture

167. MS-Word{kt zkuõÞw{uLx r«Lx fhðk fux÷k «fkhLkk ykuheyuLxuþLk
nkuÞ Au?                  swrLkÞh õ÷kfo, íkk. 25-3-2018

(A) 3 (B) 2

(C) 1 (D) 0

168. MS-Word{kt fE fe ËçkkðeLku zkuõÞw{uLxLke þYykík{kt ÃknkU[e
þfkÞ?               swrLkÞh õ÷kfo, íkk. 25-3-2018

(A) Ctrl + Home (B) Ctrl + End

(C) Home (D) Page Up

169. MS-Word{kt AuÕ÷u fhu÷k VuhVkh Ëqh fhðk {kxu fÞku ykuÃþLk
WÃkÞkuøk{kt ykðu?               swrLkÞh õ÷kfo, íkk. 25-3-2018

(A) Read (B) Redo

(C) Undo (D) Delete

170. MS-Word{kt zkuõÞw{uLxLke r«Lx fkZðk {kxu fÞk {uLkwLkku WÃkÞkuøk
ÚkkÞ?                swrLkÞh õ÷kfo, íkk. 25-3-2018

(A) File (B) Edit

(C) Insert (D) View

171. MS-Word{kt Find	Option fÞk {uLkw{kt ykðu Au?
swrLkÞh õ÷kfo, íkk. 25-3-2018

(A) Edit (B) File

(C) View (D) Insert

172. MS-Word{kt ÷¾kýLku Bold fhðk {kxu þkuxo-fx fe þwt Au?
swrLkÞh õ÷kfo, íkk. 25-3-2018

(A) Ctrl + O (B) Ctrl + S

(C) Ctrl + M (D) Ctrl + B

173. MS-Excel çkeò fÞk Lkk{Úke yku¤¾kÞ Au?
swrLkÞh õ÷kfo, íkk. 25-3-2018

(A) Word (B) Access

(C) Writer (D) Spreadsheet

152. (D) 153. (C) 154. (B) 155. (B) 156. (B) 157. (D) 158. (B) 159. (B) 160. (C) 161. (D)
162. (C) 163. (B) 164. (B) 165. (D) 166. (A) 167. (B) 168. (A) 169. (C) 170. (A) 171. (A)
172. (D) 173. (D) 

fBÃÞqxh
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174. MS-Excel{kt Mku÷(cell) A1 yLku A2Lke rft{íkLkku Mkhðk¤ku fhðk fÞwt
Mkqºk ðÃkhkÞ?                 swrLkÞh õ÷kfo, íkk. 25-3-2018

(A) A1 – A2 (B) A1 -- A2

(C) = A1 + A2 (D) W5h{ktÚke fkuE Lknª

175. ðfoçkwf yux÷u þkLkku Mk{qn ? swrLkÞh õ÷kfo, íkk. 25-3-2018

(A) Ãkºk (B) VkR÷
(C) ðfoþex (D) WÃkhLkk ík{k{

176. MS-Excel{kt yuf ðíkwo¤Lkk ½ýk çkÄk ¼køk Ëþkoðíkku fÞku [kxo Ëkuhe
þfkÞ?                swrLkÞh õ÷kfo, íkk. 25-3-2018

(A) çkkh [kxo (B) ÃkkE [kxo
(C) ÷kRLk [kxo (D) WÃkh{ktÚke fkuE Lknª

177. MS-Power Point{kt M÷kRz þku [k÷w fhðk fÞk {uLkwLkku WÃkÞkuøk ÚkkÞ
Au?                               swrLkÞh õ÷kfo, íkk. 25-3-2018

(A) File (B) View

(C) Insert (D) WÃkh{ktÚke fkuE Lknª

178. rLkÞ{kuLkk Mk{qnLku fÞk Lkk{Úke yku¤¾ðk{kt ykðu Au?
swrLkÞh õ÷kfo, íkk. 25-3-2018

(A) «kuxkufku÷ (B) «uÂõxMk
(C) Ãkuhk{kWLx (D) WÃkh{ktÚke fkuE Lknª

179. LkuxðfoLkwt Lkuxðfo fÞk Lkk{Úke yku¤¾kÞ Au?
swrLkÞh õ÷kfo, íkk. 25-3-2018

(A) Lkuxðfo (B) RLxhLkux
(C) ELxÙkLkux (D) MkwÃkh Lkuxðfo

180. RLxhLkuxLke {ËËÚke Úkíkkt ÄtÄkfeÞ ðnuðkhku fÞk Lkk{Úke yku¤¾kÞ
Au?                  swrLkÞh õ÷kfo, íkk. 25-3-2018

(A) e-Governance (B) e-Commerce

(C) e-mail (D) WÃkh{ktÚke fkuE Lknª

181. Lke[uLkk{ktÚke fÞwt ðuçk çkúkWÍh LkÚke ?   swrLkÞh õ÷kfo, íkk. 25-3-2018

(A) RLxhLkux yuûkÃ÷kuhh (B) ykuÃkuhk
(C) økqøk÷ {uE÷ (D) økqøk÷ ¢ku{

182. ðuçkMkkRxLkk «Úk{ ÃkusLku fÞk Lkk{Úke yku¤¾ðk{kt ykðu Au?
swrLkÞh õ÷kfo, íkk. 25-3-2018

(A) Home (B) House

(C) Front (D) WÃkh{ktÚke fkuE Lknª

183. ðuçkMkkRxLkk MkhLkk{kLku þwt fnuðkÞ? swrLkÞh õ÷kfo, íkk. 25-3-2018

(A) IP (B) www

(C) URA (D) URL

184. E-mail{kt TextLke MkkÚku File Ãký {kuf÷ðe nkuÞ íkku fÞwt çkxLk ðÃkhkÞ
Au?                 swrLkÞh õ÷kfo, íkk. 25-3-2018

(A) yuxu[{uLx (B) MkuLz
(C) LÞq {uE÷ (D) WÃkh{ktÚke fkuE Lknª

185. Lke[uLkk{ktÚke fÞwt ‘ÃkkMkðzo’ {kxu Mkk[wt LkÚke ? õ÷kfo, íkk. 16-9-2018

(A) ÃkkMkðzo ykÕVkLÞw{urhf r{õMz fuhuõxhLkku nkuðku òuEyu.
(B) ÃkkMkðzo Mknu÷kEÚke ÞkË hne òÞ íkuðku nkuðku òuEyu.
(C) ÃkkMkðzo ðÄw{kt ðÄw 6 fuhuõxhLkku nkuðku òuEyu.
(D) ÃkkMkðzo ÍzÃkÚke yLku Mknu÷kEÚke xkRÃk ÚkE þfu íkuðku

nkuðku   òuEyu.

186. fBÃÞqxh{kt zuxk Mktøkún fhðk ytøkuLkku MkkiÚke {kuxku yuf{ fÞku?
swrLkÞh õ÷kfo, íkk. 25-3-2018

(A) økeøkk çkkRx (B) rf÷ku çkkRx
(C) xuhk çkkRx (D) {uøkk çkkRx

187. fBÃÞqxh «kuøkúk{{kt ykðíke ‘error’Lku þwt fnuðkÞ ? õ÷kfo, íkk. 16-9-2018

(A) ðkRhMk (B) çkøk
(C) ¢uMk (D) Ãkkðh VuRÕÞkuh

188. Temporary memory of computer is –       Vkuh{uLk RLMxÙõxh, íkk. 11-2-2018

(A) ROM (B) secondary memory
(C) both A and B (D) RAM

189. MS Power Point {kt fkuE [ku¬Mk M÷kEzLku Mktíkkzðk {kxu fÞk {uLkw-
rðfÕÃkLkku WÃkÞkuøk fhðk{kt ykðu Au ?

Vkuh{uLk RLMxÙõxh, íkk. 11-2-2018

(A) Toos → Hide Slide (B) View → Hide Slide
(C) Format → Hide Slide (D) Slide Show → Hide Slide

190. MS word zkuõÞw{uLxLke þYykíkLkk ¼køk{kt sðk {kxu fE þkuxoõx
fe Lkku WÃkÞkuøk fhðk{kt ykðu Au ?    swrLkÞh RLMÃkuõxh, íkk. 4-3-2018

(A) Ctrl + Home (B) Alt + Home
(C) Shift	+	Home	 (D) Tab	+	Home

191. Maximize fhu÷ rðLzku{kt Maximize çkxLkLkk MÚkkLku fÞwt çkxLk òuðk
{¤u Au?        swrLkÞh RLMÃkuõxh, íkk. 4-3-2018

(A) Minimize (B) Restore

(C) Reset (D) Store

192. Ms Word{kt xkR®ÃkøkLke ¼q÷ ykÃk{u¤u MkwÄkhðk {kxu fÞku rðfÕÃk
WÃkÞkuøke çkLku Au ?

rV{u÷ MxkV LkMko (ykÞwðuoËk MkŠðMk), íkk. 11-3-2018

(A) Auto Spell (B) Auto Update

(C) Auto Correct (D) Auto Type

193. MS Word{kt ÃkusLku ykzwt Ëþkoððk {kxu fÞk rðfÕÃkLkku WÃkÞkuøk
fhðk{kt ykðu Au ?     rV{u÷ MxkV LkMko (ykÞwðuoËk MkŠðMk), íkk. 11-3-2018

(A) Landscape (B) Portrait

(C) Column (D) Row

194. VkÞh ðkuÕMk (Fire walls) fkuLke Mkk{u hûký {u¤ððk ðÃkhkÞ Au?
õ÷kfo, íkk. 16-9-2018

(A) yLkyrÄf]ík nw{÷k
(B) ðkRhMkLkk nw{÷k
(C) ykøkLkk nw{÷k
(D) {krníke MktçktrÄík nw{÷k

195. Ms Word{kt VkuLx MkkRÍLkk zÙkuÃkzkWLk r÷Mx{kt MkkiÚke {kuxe MkkRÍ
fux÷e nkuÞ Au ?  hkuÞÕxe RLMÃkuõxh (ðøko 3), íkk. 1-4-2018

(A) 62 (B) 72

(C) 82 (D) 92

196. MS Word{kt fE þkuxofx feLkku WÃkÞkuøk fheLku hrsMxzoLkku ÷kuøkku
 W{uhe þfkÞ Au ? hkuÞÕxe RLMÃkuõxh (ðøko 3),, íkk. 1-4-2018

(A) Ctrl + Tab + R (B) Ctrl	+	Shift	+	R

(C) Ctrl + Alt + R (D) Shift	+	Alt	+	R

174. (C) 175. (C) 176. (B) 177. (B) 178. (A) 179. (B) 180. (B) 181. (C) 182. (A) 183. (D)
184. (A) 185. (C) 186. (C) 187. (B) 188. (D) 189. (D) 190. (A) 191. (B) 192. (C) 193. (A)
194. (B) 195. (B) 196. (C)
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197. MS Word{kt H2O{kt 2Lku fE yMkh ykÃkðk{kt ykðu÷ Au ?
hkuÞÕxe RLMÃkuõxh (ðøko 3),, íkk. 1-4-2018

(A) Superscript (B) Subscript
(C) Upperscript (D) Lowerscript

198. CD ƒ™o fhðk {kxu fÞk ‚ku^xðuh™ku W…Þku„ fhðk{kt
ykðu Au  ?   Mkeðý Mkt[kr÷fk ðøko 3, íkk. 18-2-2018

(A) Nero (B) Neno
(C) WriteCD (D) NewCD

199. ‚k{kLÞ heŒu DVD™e ‚t„únûk{Œk fux÷e nkuÞ Au ?
Mkeðý Mkt[kr÷fk ðøko 3, íkk. 18-2-2018

(A) 4.7 KB (B) 4.7 MB

(C) 4.7 GB (D) 4.7 TB

200. ™e[u™k{ktÚke fÞku rðfÕ… ™uxðfo™ku «fkh Ëþkoðu Au ?
ÃkþwÄLk rLkheûkf (ðøko 3), íkk. 24-2-2018

(A) WAN (B) VAN

(C) BAN (D) GAN

201. MS Excel VkR÷™wt yuõ‚xuLþ™ þwt nkuÞ Au ?
BÞwrLkrMkÃk÷ MkurLkxhe RLMÃkuõxh, íkk. 18-2-2018

(A) .ods (B) .xls

(C) .exc (D) .exl

202. E-{uE÷{kt ™e[u™k …ife fE fk{„ehe VõŒ yuf s ð¾Œ fhðk™e
nkuÞ Au ?         E÷urõxÙf Mkçk RLMÃkuõxh (ðøko 3), íkk. 8-4-2018

(A) Sign in (B) Sign out

(C) Sign up (D) yk…u÷ Œ{k{

203. Lke[uLkk{ktÚke fkuLku ‘Back up’ fnuðkÞ ? õ÷kfo, íkk. 16-9-2018

(A) Mkwhûkk {kxu VkR÷Lke çku fu ðÄw fkuÃkeyku hk¾ðe
(B) fBÃÞqxhLku Mkr¢Þ fhðwt
(C) {ìøLkurxf xuÃk fu rzMf hk¾ðk {kxuLkwt MkkÄLk
(D) fBÃÞqxh zuxkLkwt {q¤¼qík yuf{

204. fe-ƒkuzo{kt Delete fe «u‚ fhðkÚke f‚oh™e fE ƒksw™k yûkh Ëqh
Úkþu ?           E÷urõxÙf Mkçk RLMÃkuõxh (ðøko 3), íkk. 8-4-2018

(A) zkƒe (B) s{ýe
(C) W…h (D) ™e[u

205. fBÃÞqxh VheÚke [k÷w fhðk {kxu Lke[uLkk{ktÚke fE MktÞkusLk fe
ðkÃkhðe ?        õ÷kfo, íkk. 16-9-2018

(A) Ctrl + S (B) Ctrl + F4
(C) Ctrl	+	Alt	+	Del	 (D) Ctrl	+	Alt	+	Shift

206. su [kuõõ‚ {krnŒe fu r[ºk Cut fu Copy fÞwO nþu Œu su søÞkyu
òuEŒwt nkuÞ íÞkt ÃkuMx fhðk {kxu rðfÕÃk{kt ykÃku÷ Ãkife fÞku f{kLz
ykÃkðk™ku nkuÞ Au ?        LkkÞçk r[xLkeMk, íkk. 23-11-2018

(A) Ctrl + A (B) Ctrl + S

(C) Ctrl + V (D) Ctrl + C

207. MS Word zkuõÞw{uLxLke MkkiÚke WÃkhLkk çkkhLku þwt fnu Au ?
LkMko ðøko 3, íkk. 1-4-2018

(A) {uLkwçkkh (B) xkEx÷çkkh
(C) xkMfçkkh (D) MxuxMkçkkh

208. MS word{kt MÃku®÷økLke ¼q÷ Ähkðíkk þçËLke Lke[uLkk ¼køk{kt fÞk
htøkLke ðktfe[qfe ÷exe òuðk {¤u Au ?  LkMko ðøko 3, íkk. 1-4-2018

(A) ÷e÷k (B) ÷k÷
(C) ðkË¤e (D) fk¤k

209. MS Word VkR÷Lkwt yuõMkxuLþLk þwt nkuÞ Au ?  LkMko ðøko 3, íkk. 1-4-2018

(A) .wor (B) .doc
(C) .odt (D) .wrt

210. MS Word {kt fE þkuxofx feLkku WÃkÞkuøk fheLku fkuÃkehkRxLkku ÷kuøkku
© W{uhe þfkÞ Au?  Vqz MkuVxe ykurVMkh ðøko 3, íkk. 4-3-2018

(A) Ctrl + Shift + C

(B) Ctrl + Alt + C

(C) Shift + Alt + C

(D) Ctrl + Tab + C

211. MS Word{kt fux÷k «fkhLkk zkuõÞw{uLx ykurhyuLxuþLk WÃk÷çÄ Au?
Vqz MkuVxe ykurVMkh ðøko 3, íkk. 4-3-2018

(A) 2 (B) 3
(C) 4 (D) 5

212. MS Word{kt 15th August {kt th Lku fE yMkh ykÃkðk{kt ykðu÷ Au?  
Vqz MkuVxe ykurVMkh ðøko 3, íkk. 4-3-2018

(A) Superscript (B) Subscript
(C) Upperscript (D) Lowerscript

213. Lke[uLkk{ktÚke ‘ÃkMkoLk÷ RLVku{uoþLk {ìLkush’ fÞwt?
rMkrLkÞh õ÷kfo, íkk. 19-8-2018

(A) yu{. yuMk. ykWx÷wf
(B) RLxhLkux yuûÃ÷kuhh
(C) yu{. yuMk. ykuøkuoLkkRÍh
(D) yu{. yuMk. yuõMkuMk

214. Lke[uLkk{ktÚke fÞwt fBÃÞqxhLkwt RLkÃkwx rzðkRMk LkÚke?
rMkrLkÞh õ÷kfo, íkk. 19-8-2018

(A) fe çkkuzo (B) òuÞÂMxf
(C) {kurLkxh (D) {kR¢kuVkuLk

215. Lke[uLkk{ktÚke fÞwt VheÚke WÃkÞkuøk{kt ÷E þfkÞ íkuðwt ykuÂÃxf÷
Mxkuhus rzðkRMk Au?        rMkrLkÞh õ÷kfo, íkk. 19-8-2018

(A) Mkeze (CD)

(B) zeðeze (DVD)

(C) ykhÃkeyu{ (RPM)

(D) Mkeze - ykhzçkÕÞw (CD - RW)

216. fBÃÞqxh{kt RLxhLkux yufkWLx MkkÚku fLkuõx ÚkðkLke ÃkØríkLku þwt
fnuðkÞ ?         rMkrLkÞh õ÷kfo, íkk. 19-8-2018

(A) ÷kuøk ELk
(B) ÷kuøk ykWx
(C) MkkRLk ELk
(D) MkkRLk ykWx

197. (B) 198. (A) 199. (C) 200. (A) 201. (B) 202. (C) 203. (A) 204. (B) 205. (C) 206. (C)
207. (B) 208. (B) 209. (B) 210. (B) 211. (A) 212. (A) 213. (A) 214. (C) 215. (D) 216. (A)

fBÃÞqxh
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217. Lke[uLkk{ktÚke fÞwt Lk nkuÞ íkku fBÃÞqxh [k÷w ÚkE þfu Lknª ? (Boot 
Problem)                rMkrLkÞh õ÷kfo, íkk. 19-8-2018

(A) fkuBÃkkÞ÷h (B) ÷kuzh
(C) ykuÃkhu®xøk rMkMx{ (D) yuMkuBçk÷h

218. ‘VuõMk’Lkwt Ãkqhwt Lkk{ þwt ? EDP {uLkush, íkk. 9-9-2018

(A) Vkuh ykuÕxhLkurxð Íuhkuûk
(B) VkMx ykuÕxhLkurxð ykuV Íuhkuûk
(C) VkMx yðu Íuhkuûk
(D) Vkh yðu Íuhkuûk

219. ............... yu ykuÃkhu®xøk rMkMx{Lkwt nkxo Au.  EDP {uLkush, íkk. 9-9-2018

(A) ÞwÍh RLxhVuMk (B) fLko÷
(C) f{kLz «kuÃÃkx (D) Mkuzâw÷h

220. «kuøkúk{Lkk su ¼køk{kt shared memory access fhe þfkÞ Au íkuLku
þwt fnu Au?    EDP {uLkush, íkk. 9-9-2018

(A) shared rhrsÞLk (B) locking rhrsÞLk
(C) critical MkuõþLk (D) heap

221. CPU scheduling{kt «kuMkuMkLkku ðuR®xøk xkR{{kt þkLkku Mk{kðuþ
ÚkkÞ Au?    EDP {uLkush, íkk. 9-9-2018

(A) «kuMkuMk sux÷ku Mk{Þ execute ÚkkÞ íku
(B) «kuMkuMk sux÷ku Mk{Þ I/O fhu íku
(C) «kuMkuMk sux÷ku Mk{Þ ready queue{kt ðeíkkðu íku
(D) WÃkhLkk çkÄk s

222. «kuMkuMkLku Mkçkr{x yLku yuLkku Ãkqýo ÚkðkLkk Mk{Þ ðå[uLkk ytíkhk÷Lku
............. xkR{ fnu Au. EDP {uLkush, íkk. 9-9-2018

(A) execution	 (B) response
(C) waiting	 (D) turnaround

223. IP yuzÙuMk ............ çkexLkwt yLku EÚkhLkux yuzÙuMk ............ çkexLktw 
nkuÞ Au. EDP {uLkush, íkk. 9-9-2018

(A) 32, 32 (B) 48, 32

(C) 32, 48 (D) 48, 48

224. GPULkwt Ãkqhwt Lkk{ EDP {uLkush, íkk. 9-9-2018

(A) General Processing Unit

(B) Graphics Processing Unit

(C) Gaming Processing Unit

(D) WÃkhkuõík fkuE Lknª.

225. UIDIALkwt Ãkqhwt Lkk{ EDP {uLkush, íkk. 9-9-2018

(A) Unique	 Identification	Agency	of	 India
(B) Unique	 Identification	Authority	of	 India
(C) Unique Icard Authority of India

(D) WÃkhLkkt fkuE Lknª.

226. ðíko{kLk{kt fBÃÞqxhLke fE ÃkuZe fkÞo fhe hne Au ?
Mkçk ykurzxh / Mkçk yufkWLxLx, íkk. 23-9-2018

(A) [kuÚke (B) Ãkkt[{e
(C) Aêe (D) Mkkík{e

227. [k÷w fBÃÞqxhLku rhMxkxo fheyu íkuLku þwt fnuðkÞ?
Mkçk ykurzxh / Mkçk yufkWLxLx, íkk. 23-9-2018

(A) ç÷w®{øk (B) økúw®{øk
(C) rhçkw®xøk (D) õ÷ku®Lkøk

228. CD ROM {kt zuxk þuLkk îkhk Mktøkún ÚkkÞ Au?
Mkçk ykurzxh / Mkçk yufkWLxLx, íkk. 23-9-2018

(A) CD-zÙkRð (B) CD-hkRxh
(C) ^÷kuÃke (D) fkuÃkeyh

229. Mxkxo {uLkw ykuÃkLk fhðk {kxuLke þkuxofx fe fE Au?
Mkçk ykurzxh / Mkçk yufkWLxLx, íkk. 23-9-2018

(A) Alt	+	Esc	 (B) Shift	+	Esc
(C) Alt + Del (D) Ctrl + Esc

230. fBÃÞqxh{kt VkELz (Find) {kxu yu{.yuMk.ðzo{kt fE þkuxofx fe Au?
Mkçk ykurzxh / Mkçk yufkWLxLx, íkk. 23-9-2018

(A) Ctrl + F3

(B) Ctrl + S

(C) Ctrl + F

(D) ºký{ktÚke yufÃký Lknª.

231. fBÃÞqxh{kt VkuLx ÃkkuRLx{kt {kÃkðk{kt ykðu Au. yuf #[ çkhkçkh
fux÷k ÃkkuRLx?       Mkçk ykurzxh / Mkçk yufkWLxLx, íkk. 23-9-2018

(A) 72 (B) 24

(C) 36 (D) 48

232. fBÃÞqxh{kt fk{økehe Ëhr{ÞkLk {kWMk ðzu þçËLku fuðe heíku rMk÷uõx
fhe þfkÞ?     Mkçk ykurzxh / Mkçk yufkWLxLx, íkk. 23-9-2018

(A) zÙuøk E{us ykWxMkkEz
(B) yuf õ÷ef fheLku
(C) Ctrl + õ÷ef fheLku
(D) çku õ÷ef fheLku

233. fBÃÞqxh{kt English to Gujarati {uLkw çkË÷ðkLkku Mkk[ku ¢{ fÞku ?
Mkçk ykurzxh / Mkçk yufkWLxLx, íkk. 23-9-2018

(A) Start → Progrramme → Default Programme → Control Panel →
Gujarati → OK

(B) Start → Control Panel → Format → Gujarati →  OK
(C) Start → Document → Format → Gujarati → OK
(D) Start → Control Panel → Clock, Language and Region →

Language and Region → Format → Gujarati → OK

234. yu{. yuMk. ykWx÷wf{kt Lke[uLkk{ktÚke fÞwt fkÞo fhe þfkÞ  Au?

(1) yuzÙuMk çkwf   (2) yuxu[{uLx   (3) rMkøLku[h
Mkçk ykurzxh / Mkçk yufkWLxLx, íkk. 23-9-2018

(A) (1), (2) yLku (3) ºkýuÞ
(B) Võík (1)

(C) Võík (3)

(D) (1) yLku (2)

235. fÞku ykuÃþLk ykÃk{u¤u s Mkk{kLÞ xkR®Ãkøk MÃku®÷øk{kt Úkíke ¼q÷ku
MkwÄkhu Au?      ftzõxh, íkk. 10-6-2018

(A) ykuxku Mkk{u÷ fhku (B) ykuxku fhuõx
(C) ykuxku RLMkxo (D) ykuxku [uf

217. (C) 218. (D) 219. (B) 220. (C) 221. (C) 222. (D) 223. (C) 224. (B) 225. (B) 226. (B)
227. (C) 228. (B) 229. (D) 230. (C) 231. (A) 232. (D) 233. (D) 234. (A) 235. (B)
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236. ðuçk ftxuLx «ËŠþík fhðk {kxu fE ¼k»kkLkku WÃkÞkuøk ÚkkÞ Au?
ftzõxh, íkk. 10-6-2018

(A) C (B) HTML
(C) BASIC (D) PROLOG

237. M«uzþex{kt yk÷u¾ W{uhðk fÞk {uLkwLkku WÃkÞkuøk ÚkkÞ Au?
ftzõxh, íkk. 10-6-2018

(A) Insert + Tools (B) Insert + Chart
(C) View + Chart (D) Data + Chart

238. fuÕMke{kt çkLkkðu÷ ðfoþexLkwt yLkw÷tçkLk þwt nkuÞ Au?
ftzõxh, íkk. 10-6-2018

(A) .ods (B) .odd

(C) .xls (D) .obj

239. Lke[u{ktÚke fÞwt íkkŠff rðÄuÞ LkÚke? ftzõxh, íkk. 10-6-2018

(A) OR (B) AND

(C) NOT (D) Proper

240. BMPLkwt Ãkqhwt Lkk{ þwt Au?   ftzõxh, íkk. 10-6-2018

(A) rçkx {uÃk rÃkõ[h
(B) rçkx {uÃk ÃkuÃkh
(C) rçkx {uÃk «kuxkufku÷
(D) WÃkhkuõík ík{k{

241. fÞk MÚkkLkktfLkkt MkqºkLke Lkf÷ fhðkÚke fu ¾MkuzðkÚke íku{kt fkuE
ÃkrhðíkoLk ykðíkwt LkÚke?     ftzõxh, íkk. 10-6-2018

(A) rLkhÃkuûk MÚkkLkktf (Absolute Address)

(B) MkkÃkuûk MÚkkLkktf (Relative Address)

(C) MktÞwõík MÚkkLkktf (Mixed Address)

(D) ykÃku÷ ík{k{

242. Lke[u{ktÚke fÞku økwýÄ{o AçkeLke Ÿ[kE yLku Ãknku¤kELke ®f{ík
rÃkõMku÷{kt Ëþkoðu Au?      ftzõxh, íkk. 10-6-2018

(A) Img Src (B) Height yLku width

(C) H yLku V (D) ykÃku÷k fkuE Ãký

243. yuõMkLko÷ Mxkuhus íkhefu fkuLkku Mk{kðuþ fhe þfkÞ ?
ftzõxh, íkk. 10-6-2018

(A) ykuÂÃxf÷ rzMf (B) RAM

(C) ROM (D) hrsMxh

244. RLkÃkwx rzðkRMk íkhefu fkuLkku Mk{kðuþ fhe þfkÞ ?
ftzõxh, íkk. 10-6-2018

(A) {kurLkxh (B) r«Lxh
(C) «kusuõxh (D) xÙuf çkku÷

245. nkzoðuh yLku Mkkì^xðuhLku òuzðkLkwt fk{ fkuý fhu Au?
ftzõxh, íkk. 10-6-2018

(A) Operating	System
(B) Programming Language
(C) CPU
(D) Application	Program

246. LkkLkk{kt LkkLkku ÞwrLkx fÞku Au? ftzõxh, íkk. 10-6-2018

(A) BIT (B) BYTE
(C) WORD (D) DOUBLE

247. Notepad fÞk «fkhLkwt Mkkì^xðuh Au? ftzõxh, íkk. 10-6-2018

(A) «Míkwrík (B) Þwxer÷xe
(C) rMkMx{ (D) yk{ktÚke yuf Ãký Lkrn.

248. MS-Word yu ............ «kuøkúk{ Au.    ftzõxh, íkk. 10-6-2018

(A) ðzo «kuMku®Mkøk (B) «uÍLxuþLk
(C) rMkMx{ (D) yk{ktÚke yuf Ãký Lkrn.

249. fe çkkuzo{kt fux÷e VtõþLk fe òuðk {¤u? ftzõxh, íkk. 10-6-2018

(A) 8 (B) 12
(C) 14 (D) 16

250. hì{ yux÷u þwt?    ftzõxh, íkk. 10-6-2018

(A) hìLz{ yuõMkuMk {u{he (B) hez yk^xh {u{he
(C) hezh yuMkurMkçk÷ {u{he (D) hìLz{ y÷kRLk {u{he

251. RAMLkku Mk{kðuþ fÞk «fkhLke {u{he íkhefu ÚkkÞ Au?
ftzõxh, íkk. 10-6-2018

(A) MkufLzhe {u{he
(B) «kR{he {u{he
(C) çkkÌk {u{he
(D) yk{ktÚke yuf Ãký Lkrn.

252. Lke[uLkk{ktÚke fÞwt Mk[o yuÂLsLk LkÚke? ftzõxh, íkk. 10-6-2018

(A) økqøk÷ (B) ®çkøk
(C) Þknq (D) {kurÍ÷k

253. ðuçkÃkusLku rh£uþ fhðk ............ feLkku WÃkÞkuøk ÚkkÞ Au.
ftzõxh, íkk. 10-6-2018

(A) F4 (B) F3
(C) F2 (D) F5

254. fÞwt r[nTLk E-{uE÷ ykE.ze.Lku çku ¼køk{kt ðnU[u Au?
ftzõxh, íkk. 10-6-2018

(A) # (B) @
(C) $ (D) %

255. MS Word zkuõÞw{uLxLke MkkiÚke WÃkhLkk çkkhLku þwt fnu Au?
Mk{ks fÕÞký rLkheûkf (ðøko 3), íkk. 7-10-2018

(A) {uLkwçkkh (B) xkRx÷çkkh
(C) xkMfçkkh (D) MxuxTMkçkkh

256. MS Word{kt ÃkuhuøkúkVLku fux÷k «fkhLkwt yu÷kRL{uLx ykÃke
þfkÞ   Au  ?             Mk{ks fÕÞký rLkheûkf (ðøko 3), íkk. 7-10-2018

(A) 2 (B) 3
(C) 4 (D) 5

257. MS Word {kt VkuLx MkkRÍLkk zÙkuÃkzkWLk r÷Mx{kt MkkiÚke {kuxe MkkRÍ
fux÷e nkuÞ Au ?           Mk{ks fÕÞký rLkheûkf (ðøko 3), íkk. 7-10-2018

(A) 62 (B) 72
(C) 82 (D) 92

258. MS Word{kt fE þkuxofx feLkku WÃkÞkuøk fheLku hrsMxzoLkku ÷kuøkku   ®
W{uhe þfkÞ Au ?      Mk{ks fÕÞký rLkheûkf (ðøko 3), íkk. 7-10-2018

(A) Ctrl + Tab + R
(B) Ctrl	+	Shift	+	R
(C) Ctrl + Alt + R
(D) Shift	+	Alt	+	R

236. (B) 237. (B) 238. (A) 239. (D) 240. (A) 241. (A) 242. (B) 243. (A) 244. (D) 245. (A)
246. (A) 247. (D) 248. (A) 249. (B) 250. (A) 251. (B) 252. (D) 253. (D) 254. (B) 255. (B)
256. (C) 257. (B) 258. (C)

fBÃÞqxh
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259. Lke[uLkk{ktÚke fÞku rðfÕÃk zkuõÞw{uLxLkwt ykuheyuLxuþLk Ëþkoðu Au?
{ËËLkeþ Mk{ks fÕÞký yrÄfkhe ðøko 3, íkk. 7-10-2018

(A) Landscap
(B) Portrait
(C) Fixed

(D) (A) yLku (B) çktLku

260. MS Word{kt H2O{kt 2 Lku fE yMkh ykÃkðk{kt ykðu÷ Au?
{ËËLkeþ Mk{ks fÕÞký yrÄfkhe ðøko 3, íkk. 7-10-2018

(A) Superscript (B) Subscript
(C) Upperscript (D) Lowerscript

261. rðLzkuÍ{kt zuMfxkuÃk Ãkh sðk {kxu fE þkuxofx feLkku WÃkÞkuøk fhðk{kt 
ykðu Au?        {ËËLkeþ Mk{ks fÕÞký yrÄfkhe ðøko 3, íkk. 7-10-2018

(A) Ctrl + D (B) Alt + D
(C) Tab + D (D) Win + D

262. M¢eLk Mkuðh {kxu ykuAk{kt ykuAku fux÷ku Mk{Þ Mkux fhe þfkÞ Au?
{ËËLkeþ Mk{ks fÕÞký yrÄfkhe ðøko 3, íkk. 7-10-2018

(A) 1 r{÷eMkufLz
(B) 1 MkufLz
(C) 1 r{rLkx
(D) 1 f÷kf

263. MS Word{kt xkR®ÃkøkLke ¼q÷ ykÃk{u¤u MkwÄkhðk {kxu fÞku rðfÕÃk 
WÃkÞkuøke çkLku Au?     {ËËLkeþ Mk{ks fÕÞký yrÄfkhe ðøko 3, íkk. 7-10-2018

(A) Auto Spell
(B) Auto Update
(C) Auto Correct
(D) Auto Type

264. MS Word{kt yûkhLku Úkkuzk Lke[uLke íkhV Ëþkoððk {kxu fkuLkku

WÃkÞkuøk fhðk{kt ykðu Au?    rnMkkçkLkeþ (ðøko 3), íkk. 25-3-2018

(A) Bottomscript
(B) Leveldownscript
(C) Lowerscript
(D) Subscript

265. MS Word{kt xkRx÷çkkhLke s{ýe çkksw fw÷ fux÷kt ftxÙku÷ çkxLMk

òuðk {¤u Au?        rnMkkçkLkeþ (ðøko 3), íkk. 25-3-2018

(A) 3 (B) 4
(C) 5 (D) 6

266. MS Word zkuõÞw{uLxLkk ytík ¼køk{kt sðk {kxu fE þkuxofx feLkku

WÃkÞkuøk fhðk{kt ykðu Au ?      rnMkkçkLkeþ (ðøko 3), íkk. 25-3-2018

(A) Ctrl + End
(B) Alt + Home
(C) Shift	+	Home
(D) Tab + Home

267. ‘M. S. Outlook’ _______    õ÷kfo, íkk. 16-9-2018

(A) yuÂLxðkRh÷ Mkku^xðuh Au.
(B) yuf òíkLkku M«uzþex Mkku^xðuh Au.
(C) {kuxu ¼køku E-{uR÷ {kxu ðÃkhkíke yuÂÃ÷fuþLk Au.
(D) yuf nkzoðuh Au.

268. M.	S.	Ofiice	 Ãkufus{kt fÞk «kuøkúk{Lkku Mk{kðuþ Úkíkku LkÚke ?
õ÷kfo, íkk. 16-9-2018

(A) ðzo (B) yuõMku÷
(C) yuõMkuMk (D) hkRxh

269. fBÃÞqxh{kt Word þY fhðk {kxuLke ¢r{f Mkk[e heík fE Au  ?
õ÷kfo, íkk. 16-9-2018

(A) yu{. yuMk. ykurVMk → Mxkxo → yku÷«kuøkúkBMk → ðzo
(B) Mxkxo → yku÷«kuøkúkBMk → yu{. yuMk. ykurVMk → yu{. yuMk. ðzo
(C) MxkhT → yu{. yu{. ykurVMk → yu{. yuMk. ykWx÷wf → ðzo
(D) Mxkxo → yu{. yuMk. ykWx÷wf → yu{. yuMk. ykurVMk → ðzo

270. yuõMk÷ ðfoþex{kt fkuE Mku÷{kt ßÞkhu fkuE {krníke Ëk¾÷ fhðk{kt
ykðu íÞkhu íku {krníke Lke[uLkk rðfÕÃk Ãkife Ãký òuE þfkÞ ?

rðMíkhý yrÄfkhe (f]r»k), íkk. 04-11-2018

(A) hku nu®zøk (B) Lku{ çkkuõMk
(C) MxuxMkçkkh (D) VkuBÞwo÷k çkkh

271. LAN Lkuxðfo{kt çku fBÃÞqxh ðå[u ðÄkhu{kt ðÄkhu fux÷wt ytíkh nkuðwt
òuEyu ?         õ÷kfo, íkk. 16-9-2018

(A) 100 {exh (B) 10 {exh
(C) 1,000 {exh (D) 10,000 {exh

272. IME þwt Au ?   õ÷kfo, íkk. 16-9-2018

(A) RLkÃkwx {þeLk yurVrþÞLMke
(B) RLkÃkwx {uÚkz yurzxh
(C) RLxhLkuþLk÷ {uÚkzMk ykuV yurz®xøk
(D) RLxÙkfBÃÞqxh {þeLk yuÂõÍõÞwþLk

273. MS ðzo{kt r«Lx zkÞ÷kuøk çkkuõMk{kt r«LxLke hUs 10 ykÃke nþu íkku
rhÍÕx þwt nþu ?       õ÷kfo, íkk. 16-9-2018

(A) 1Úke 10 Ãkus r«Lx fhþu
(B) 10Úke ÃkkA¤Lkk Ãkus r«Lx fhþu
(C) {kºk 10 LktçkhLkwt Ãkus r«Lx fhþu
(D) fBÃÞqxh M¢eLk Ãkh ‘Error’ Ëþkoðþu

274. MS ðzo{kt ðÄw{kt ðÄw fux÷wt Íq{ fhe þfkþu ?
õ÷kfo, íkk. 16-9-2018

(A) 500% (B) 400%
(C) 300% (D) 5000%

275. {kR¢kuMkku^xLkk «ýuíkk fkuý ? õ÷kfo, íkk. 16-9-2018

(A) [kÕMko çkuçkus (B) YÃkxo {zkuof
(C) yuzkuçk (D) rçk÷ økuxTMk

276. ‘ASCII’ fkuz{kt fw÷ fux÷k fkuz rVõMk fhu÷ Au ?
õ÷kfo, íkk. 16-9-2018

(A) 254 (B) 255
(C) 256 (D) 251

277. VkR÷Lke MkkRÍ fBÃÞqxh{kt ________ {kt {kÃkðk{kt ykðu Au.
õ÷kfo, íkk. 16-9-2018

(A) fkRx (B) çkkRx
(C) çkex (D) fuhuõxh

259. (D) 260. (B) 261. (D) 262. (C) 263. (C) 264. (D) 265. (A) 266. (A) 267. (C) 268. (D)
269. (B) 270. (D) 271. (A) 272. (B) 273. (C) 274. (A) 275. (D) 276. (C) 277. (B)



16 õ÷kMk-3 (rð»kÞðkh «§ku)

287. XML Lkwt Ãkqhwt Lkk{ þwt Au ?
r‚r™Þh õ÷kfo …heûkk, 13-08-2017;

ykurVMk MkwÃkrhLxuLzuLx, 04-10-2015

(A) Extensible Markup Language
(B) Extreme Memory Language
(C) Extensible Memory Line
(D) Extra Markup Language

288. ISP stands for :
{ËËLkeþ Mk{ks fÕÞký yrÄfkhe (ð„o 3), 27-05-2018

r‚r™Þh Wãku„ r™heûkf (ð„o 3), 07-05-2017;
Ãkku÷eMk fkuLMxuçk÷ íkÚkk su÷ rMkÃkkne, 23-10-2016

(A) Internet Survey Period
(B) Integrated Service Provider
(C) Internet Service Provider
(D) Internet Security Protocol

289. USBLkwt Ãkqhwt Lkk{ þwt Au ?
rçkLk-Mkr[ðk÷Þ fkhfwLk yLku Mkr[ðk÷Þ ykurVMk ykrMkMxLx, 16-10-2016;

{ËË™eþ ykrËòrŒ rðfk‚ yrÄfkhe (ð„o 3), 18-12-2016;
Ãkku÷eMk Mkçk-RLMÃkufxh íkÚkk {ËËLkeþ Ãkku÷eMk Mkçk-RLMÃkuõxh, 01-01-2017

(A) Universal Source Bus
(B) Universal Serial Bus
(C) Universal	 Section	Bus
(D) Universal Socket Bus

290. ModemLkwt Ãkqhwt Lkk{ þwt Au ?
{ËËLkeþ Mk{ks fÕÞký yrÄfkhe (ð„o 3), 27-05-2018

rçkLk-Mkr[ðk÷Þ fkhfwLk yLku Mkr[ðk÷Þ ykurVMk ykrMkMxLx, 16-10-2016;
{nuMkq÷e ík÷kxe, Section-A, 28-02-2016

(A) Modul Demodul

(B) Modular Demodular

(C) Modulator Demodulator

(D) Modulation	Demodulation

291. yuf s Y{, rçk®Õzøk fu ÃkrhMkh{kt ykðu÷kt fBÃÞqxMkoLku yufçkeòLke
MkkÚku òuzðk {kxu fÞk LkuxðfoLkku WÃkÞkuøk fhðk{kt ykðu Au ?

rçkLk-Mkr[ðk÷Þ fkhfwLk yLku Mkr[ðk÷Þ ykurVMk ykrMkMxLx, 16-10-2016;
Ãkuxk-rnMkkçkLkeþ/Mkçk-ykurzxh, 13-09-2015

(A) LAN

(B) MAN
(C) WAN
(D) FAN

292. fBÃÞqxhLku rh£uþ fhðk fE feLkku WÃkÞkuøk fhkÞ Au ?
ƒur÷V (ð„o 3), M{]rŒ ykÄkrhŒ, 19-11-2017;

swrLkÞh ykrMkMxLx, 06-03-2016

(A) F5

(B) F8
(C) F6
(D) F7

293. PDF Lkwt Ãkqhwt Lkk{ þwt Au ?
nuz õ÷kfo / ‚{ks fÕÞký r™heûkf …heûkk, 30-04-2017;

Ãkku÷eMk fkuLMxuçk÷ íkÚkk su÷ rMkÃkkne, 23-10-2016

Lk‹Mkøk xâqxh (ðøko 3), (ÃkuÃkh-2), íkk. 9-9-2018

(A) Portable Document File
(B) Portable Document Folder
(C) Portable Document Format
(D) Portable Document Form

ðkhtðkh ÃkwAkÞu÷k «§ku

278. abc@gmail.com{kt gmail þwt Au? yufkWLxLx RLMÃkuõxh (ð„o 3), 25-02-2018

MkkWLz rMkMx{ ÃkuLk÷ ykuÃkhuxh (ðøko 3), íkk. 10-2-2018

(A) yuõMxuLþLk (B) nkuMx Lku{
(C) økuMx Lku{ (D) ÞwÍh Lku{

279. Thesaurus {kxuLke þkuxofx fe fE Au ?
Vkuh{uLk RLMxÙõxh, íkk. 11-2-2018

rçkLk-Mkr[ðk÷Þ fkhfwLk yLku Mkr[ðk÷Þ ykurVMk ykrMkMxLx, 16-10-2016
(A) F7 (B) Ctrl + F7
(C) Shift	+	F7	 (D) Alt	+	F7

280. MS Word{kt MÃku®÷øk yLku økúk{hLke [fkMkýe fhðk {kxu fE VtfþLk
feLkku WÃkÞkuøk fhðk{kt ykðu Au ? {nuMkq÷e ík÷kxe, Section-A, 28-02-2016

rVÕz ykurVMkh õ÷kMk-3, íkk. 11-3-2018
õ÷kfo, íkk. 16-9-2018

(A) F6 (B) F7

(C) F8 (D) F9

281. fe-çkkuzo Backspace fe «uMk fhðkÚke fMkohLke fE çkkswLkk yûkh
Ëqh Úkþu ?  MkkWLz rMkMx{ ÃkuLk÷ ykuÃkhuxh (ðøko 3), íkk. 10-2-2018

E÷urõxÙf Mkçk RLMÃkuõxh (ðøko 3), íkk. 8-4-2018

(A) zkçke (B) s{ýe
(C) WÃkh (D) Lke[u

282. fe-çkkuzoLke «Úk{ ÷kRLk{kt zkçke çkkswÚke s{ýe çkkswLke feLkku ¢{
fÞku nkuÞ Au ?

nuz fkuLMxuçk÷ (s{kËkh), 20-05-2018
rçkLk-Mkr[ðk÷Þ fkhfwLk yLku Mkr[ðk÷Þ ykurVMk ykrMkMxLx, 16-10-2016

(A) POIUY (B) ASDFG

(C) QWERT (D) ZXCV

283. Mkk{kLÞ heíku IP yuzÙuMk fux÷k çkexLkwt çkLku÷wt nkuÞ Au ?
{ËËLkeþ Mk{ks fÕÞký yrÄfkhe (ð„o 3), 27-05-2018

Ãkuxk-rnMkkçkLkeþ/Mkçk-ykurzxh, 13-09-2015

(A) 8 (B) 16

(C) 32 (D) 64

284. fBÃÞqxh ÃkhÚke {krníkeLku Mkðoh WÃkh {kuf÷ðkLku þwt fnu Au ?
{ËËLkeþ Mk{ks fÕÞký yrÄfkhe (ð„o 3), 27-05-2018

swrLkÞh ykrMkMxLx, 06-03-2016

(A) zkWLk÷kuz (B) yÃk÷kuz
(C) MkuLz (D) rhÃ÷kÞ

285. MS Word{kt yûkhLku Úkkuzk Lke[uLke íkhV Ëþkoððk {kxu fkuLkku WÃkÞkuøk
fhðk{kt ykðu Au?

nuz fkuLMxuçk÷ (s{kËkh), 20-05-2018
yufkWLxLx, 25-03-2018

(A) Bottomscript (B) Leveldownscript

(C) Lowerscript (D) Subscript

286. GUILkwt Ãkqhwt Lkk{ þwt Au ?
r‚r™Þh õ÷kfo …heûkk, 13-08-2017;

{ËË™eþ ykrËòrŒ rðfk‚ yrÄfkhe (ð„o 3), 18-12-2016
swrLkÞh õ÷kfo, íkk. 25-3-2018

(A) Graphical User Interface

(B) Geographical Use of Internet

(C) Giga Uses of Internet

(D) Graphics Unlimited Interface
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fBÃÞqxh




